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Introduction
The learner guide for Gems and Jewellery sector of “Jewellery CAD/CAM” will provide an

insight to the development of the Gem and Jewellery industry on modern means of
technological advancements. It will provide an opportunity to the learner in better
understanding of the use of Jewellery CAD/CAM software in providing state of the art
solutions to the customers. A special care is observed in designing the learner guide to bring
an easy solution in understanding with examples and practical exercises for your first time
users and also it will bring a lot learning opportunities for the mid-career workers in the
sector. Programme is to engage young people with a programme of development that will
provide them with the knowledge, skills and understanding in working as a well professionally
groomed worker or even starting own venture as an entrepreneur. The programme has been
developed to address specific issues, such as the national, regional and local cultures, the
manpower availability within the country, and meeting and the exceeding needs and
expectations of their customers. The main elements of your Teaching and Learning Material

are:

Introduction:

This includes a brief description of your guide and guidelines for you to use it effectively.
Modules:

The modules form the sections in your Teaching and Learning Material.

Learning Units:

Learning Units are the main sections within each module

Learning outcomes:

Learning outcomes of each learning units are taken from the curriculum document

Learning Elements:

This is the main content of your Teaching and Learning Material with detail of the knowledge
and skills (practical activities, projects, assignments, practices etc.) you will require achieving
learning outcomes stated in the curriculum.

This section will include examples, photographs and illustrations relating to each learning
outcome

Summary of modules:

This contains the summary of the modules that make up your Teaching and Learning
Material

Frequently asked questions:

These have been added to provide further explanation and clarity on some of the difficult
concepts and areas. This further helps you in preparing for your assessment.

Multiple choice questions for self-test:
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o These are provided as an exercise at the end of your Teaching and Learning Material to help

you in preparing for your assessment.
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BASIC CONCEPT OF JEWELLERY

Jewellery: is a decorative ornament to worn on body which may be an abstract or depict a

design theme having proportion, rhythm, function and wearable features.
Material or Medium used for Jewellery:

Precious Metals: like Silver, Gold, Platinum, Palladium etc.
Semi-Precious Metals: like Brass, Copper, Bronze, Lead, Zinc etc

Gem stones: are also used in jewellery, for instance: Diamond, Ruby, Emerald, Sapphire,

Aquamarine, Tourmaline, Opal, Pearl, Agate, Amethyst, Mozanite, Zirconia, Coral etc.
ERAS OF JEWELLERY DEVELOPMENT
History of Jewellery

Jewellery has been worn by the earliest civilizations. Even

Jewelry Eras | Period

those ancient bodies found frozen or entombed, all are

Georgian: 1714 -1836
found with various types of jewellery - amulets, bracelets, | \/jctorian: 1837 - 1900
earrings, etc. Edwardian: 1901 - 1910

Art Nouveau: | 1880 - 1914

Jewellery has been used as symbols of emotions Arts & Crafts: | 1890 - 1914

represented by specific stones or jewellery designs. If you | Art Deco: 1920 - 1939

decide to collect vintage and antique jewellery, you LRetro: 1935 - 1950
probably enjoy other types of antiques, as well.

Georgian Jewellery of the 1700 and 1800's

The era is named after England's Kings, George |, Il, & Ill. This was a
time when the aristocratic and wealthy classes wore an abundance of
jewels - men, as well as women. Jeweled buttons on coats and knee

breeches, pocket watches, chains, fobs and jeweled shoe buckles

were worn by both sexes.

EARLY VICTORIAN or ROMANTIC ERA 1837-1860

The Victorian era covers such a long period of time that many styles
are covered in the one name, "Victorian". Transitions were not
usually abrupt and a piece can show several influences at once. The
Art Nouveau era, for example, overlaps the time period for Victorian
jewellery but has a unique and very recognizable style. (These styles

are discussed individually.)

The Victorian Era gets it's name from England's Queen Victoria, who

ascended the throne in 1837 at the age of 18. The queen was an
influence on fashion and jewellery styles and this was particularly true during the early years

of her reig.
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One transition style that covers both the end
of the Georgian and beginning of the
Victorian eras are Ferronieres. These were
chains or ribbons studded with a center jewel

intended to be worn on the forehead.

Brooches were extremely popular and were

worn in a variety of ways; on the shoulder, of
course, but also at the neck, waist, in the hair, and on ribbons as necklaces and bracelets. In
addition to silver, gold, and base metals, jewellery was created from Pique, Tortoiseshell,
Mother-of-Pearl, and "Lava" (carved mud to form cameos. Religious symbols were mainstays
of jewellery design in both the Georgian and Victorian eras. Queen Victoria's engagement

ring from Prince Albert was in the form of a serpent.

Victorian jewellery designers loved natural themes and flowers as did earlier generations.
Early Victorian designs are generally small and delicate unlike the larger, heavier, and more

ornate pieces made later.
EDWARDIAN ERA

Lasting about a decade, the Edwardian era (named
after England's King Edward VII) was a mix of styles
and tastes. Though the era was a short one, jewellery
pieces can easily be found. New technology allowing
faster manufacture of items reduced costs and made
jewellery available to more people than ever before.
Fine jewellery of the Edwardian era used a lot of
Diamonds, white Gold, and Platinum. Although

Platinum had been available earlier, it had been very

difficult to work with so the new technology made it
more practical for jewellery. Designs were made with delicacy to blend with the current tastes

for fabrics of lace and silk.

Necklaces of all kinds were very popular and can be found by the collector.
The Sautoir is a very long necklace made of beads that fall below the waist; these often have

tassels on the ends. This type of necklace would be popular through the Art Deco period.

A Lavaliere necklace is one that has a pendant suspended from a thin chain. These are the

most common types of necklaces found from this era.

Brooches with sporting motifs of fox heads, horseshoes, golf clubs, and riding crops can be

found from this time period. Bracelets were worn both singly and in multiples. The "knife
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edge" technique, previously mentioned, was used to make lightweight pieces, often set with

stones.
ART NOUVEAU ERA

Coinciding with the Victorian era, it's a style intended as
a statement against the industrialization of jewellery
making. Designs are curvy, fluid; often of nude female
figures, heads, insects, crescents, and common plants.
Jewellery of this era was considered very "avant garde"
for the time and it took a bold person who dared to wear
it.

Look for designs that incorporate

Butterflies ,Wasps , Dragonflies ,Bees ,Swans ,0Owls
,Bats ,Peacocks ,Dragons ,Poppies Sunflowers
,Dandelions , Mums ,Fantasy Creatures

The art of Japan was a new and exciting influence on
Art Nouveau with the "opening" of Japan to the West in
1853. Up until this time, it had virtually been a closed
society and society was fascinated by examples of
designs and goods from this mysterious and exotic
country. Scenes of nature, done in this style with its
simplicity and understatement, made a major impact on
European arts and designs. The beautiful jewel-toned
enamels, widely used in Japan for centuries, were now

duplicated in Art Nouveau and Arts & Crafts designs.
ARTS & CRAFTS ERA

The Arts and Crafts movement was a transitional period
between the Art Nouveau and Art Deco eras. You can often
see elements of both styles in a single piece of jewellery. Arts
& Crafts was more than just a design style; it was a political
and philosophical movement. Devotees of this art form
interested themselves in social reform and individual rights.
The style was a revolt against new technology they felt was
destroying craftsmanship. It was their view that the
imperfections and inconsistencies of hand-made pieces

increased the beauty of a piece.
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In Arts and Crafts jewellery, cabochon cuts were preferred over faceted stones and Silver

was the preferred metal over gold. As with Art Nouveau jewellery, "humble" materials, like

brass and copper, were valued and used to create jewellery. Enamel continued its popularity

in this era, but in simpler, less flowing lines than Art nouveau examples.

ART DECO ERA

The "Roaring Twenties" also called "The Jazz Age", was
a time of rapid change. U. S. women finally got the right

to vote with passage of the 19th amendment.

Fashion reflected the fact that women were more
independent than ever before. Dresses were short and

straight in new, thin fabrics with dropped waists.

Deco jewellery is often bold and angular - forming
geometrical shapes. Wildly colorful pieces were
common, but in addition to these, were ones made using
just two colors, perhaps black and white. Women again
wore multiples of everything; rings, bracelets, necklaces,
but in ways that were different from the past. In addition
to precious stones, jewellery was made of paste, coral,
crystal, and onyx. Sometimes the precious and non-
precious stones were used side-by-side to create looks

uniquely "Art Deco".

Long strands of beads and pendants were worn hanging
to the waist. Ropes of pearls or beads could be knotted
at the neck and reach to the thigh or worn with the length
in back - calling attention to a plunging dress back.

Men accessorized with cufflinks, tie bars and tiepins.
While the styles were usually simpler in ornamentation
than a similar woman's object, they showed the same

artistic style and beauty.

Costume jewellery in the 1920's and 30's was available

-
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in all kinds of material - paste, faux gems, horn, bone, and celluloid, and all were mass-

produced.

Bakelite was a staple for Art Deco costume pieces. It?s an early form of plastic that can be

molded and carved. All sorts of jewellery can be found; some pseudo-serious, some very

whimsical - like necklaces of fruit or cartoon-like brooches.
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Module 1: PREPARE DRAWING OF BASIC JEWELLERY ARTICLE MANUALLY

Introduction:

This module is an essential milestone in designing and drafting fundamentals of jewellery
article manually. It will cover the basic elements and principles of design that how trainee will
transfer ideas in to practical jewellery article. Furthermore it emphasizes the designing of
jewellery article conceptually following manufacturing techniques to produce jewellery article
with precision and accuracy. It covers the introduction and historical eras of jewellery

evolution.

The trainee will be able to sketch necessary views of jewellery article on scale. This technical
drawing will act as prerequisite for the jewellery craftsman to manufacture jewellery article

physically keeping its wear ability and aesthetics.

The course learning units are arranged in such a way to integrate concepts and ideas related
to each topic through tools and application-oriented projects. This makes the learning simple
and systematic and enables one to gain more insight knowledge on the various tools

covered.

LEARNING UNIT 1: PERFORM BASIC SKETCHING

Objectives:

In this learning unit you will learn how to “sketch” a drawing or a design often done as a
preliminary study, which acts as an essential tool for a designer to conceptualize and
communicate. The jewellery article will be sketched by free-hand through techniques of

assorted lines, correct angles, variation of lines and shapes.

LEARNING OUTCOMES

The student will be able to:
1. Analyze jewellery article on measurements

2. Draw outline sketch of basic jewellery article with free hand
3. Draw jewellery design elements.

Module 1 PREPARE DRAWING OF BASIC JEWELLERY ARTICLE MANU
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BASIC CONCEPTS:

Design:

Design is the process of selecting and organizing elements or components in order to fulfill a
specific purpose. This purpose may be functional or aesthetic, or (frequently) both.

Basic elements of design:

The elements are components or parts which can be isolated and defined in any visual
design or work of art. They are the structure of the work, and can carry a wide variety of

messages. These elements are:

* Point

* Line

* Form, shape and space
* Movement

* Color

* Pattern

* Texture

POINT

A point indicates position. It has no length or breadth. It is the beginning and end of a line,
and is where two lines meet or intersect. Even if there is only one point, one mark on a blank
page there is something built into the brain that wills meaning for it, and seeks some kind of
relationship or order. If there are two points, immediately the eye will make a connection and
"see" a line. If there are three points, it is unavoidable to interpret them as a triangle; the mind

supplies the connections. This compulsion to connect parts is described as grouping.

LINE

The most basic element of art, can take many different
forms; it can be circular, zigzag, straight, curved or
spiral for instance. Zigzag and circular lines represent
motion/ movement and can be used to create dynamic

shapes,
Types of Line

There are three types of line, the real line, the implied line and the psychic line.

The real line: is a line we can physically see and touch, for example the lines /

that appear above and below the sub-headings.

The implied line: When a series of points are positioned in a certain way, the S

eye tends to connect them together, this is the implied line. For example when
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we look at a series of dashes or dots we 'see’ a line, this line however is not actually there, it
is implied.

The psychic line: is where you create a mental connection

between various visual elements. For example there is no
line between this section of the page and the navigation bar
however you mentally 'see' a line separating the two

sections.

FORM, SHAPE AND SPACE

Form and shape are areas or masses which define objects in space. Form

and shape imply space; indeed they cannot exist without space.

Shapes can be created in a number of ways, through the use of lines or
color to define the edge and therefore enclose a space. These shapes can
then be used within compositions.

The arrangement of these forms or shapes can affect the whole i j

composition as it is more visually pleasing to look at something that is

balanced.

MOVEMENT

Movement is also a key element of art and design and can be achieved in three main ways.
These are blurred outlines, repeated figures and multiple elements.

Blurred outlines show the movement an object has been through. Therefore we can picture in
our mind the object moving, for example the image below uses this feature to provoke a

feeling of movement between the marbles.

COLOR

Color is one of the most powerful of elements. It has tremendous expressive qualities.
Understanding the uses of color is crucial to effective composition in design and the fine arts.
Color is an important part of art and design and has many properties, these are Hue (or

Chroma), Value, Brightness, Saturation and Lightness

PATTERN

Pattern is an underlying structure that organizes surfaces or structures in a consistent,
regular manner. Pattern can be described as a repeating unit of shape or form, but it can also

be thought of as the "skeleton" that organizes the parts of a composition.
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TEXTURE

Texture is the quality of an object which we sense through touch. It exists as a literal surface
we can feel, but also as a surface we can see, and imagine the sensation might have if we
felt it. Texture can also be portrayed in an image, suggested to the eye which can refer to our

memories of surfaces we have touched. So a texture can be imaginary.

Bristly, rough, and hard -- this is what we usually think of as texture, but texture can also be
smooth, cold and hard too. Smooth, soft, and/or warm and Wet or dry are also textures; in
fact, any tactile sensation we can imagine is a texture.

WHAT IS 2D & 3D?

There are various ways to categorize form and shape. Form and shape can be thought of as
either two dimensional or three dimensional. Two dimensional forms have width and height. It
can also create the illusion of three dimension objects. Three dimensional shapes have depth
as well as width and height.

ORGANIC AND GEOMETRIC FORMS

Form and shape can also be described as either organic or geometric.

Organic forms such as these snow-covered boulders typically are irregular in outline, and

often asymmetrical. Organic forms are most often thought of as naturally occurring.
Geometric forms are those which correspond to named regular shapes, such as squares,

rectangles, circles, cubes, spheres, cones, and other regular forms.

PRINCIPLES OF DESIGN

The Principles are concepts used to organize or arrange the structural elements of design.
Again, the way in which these principles are applied affects the expressive content, or the

message of the work. These are as follows :
+ Balance
» Proportion
*  Rhythm
+ Emphasis
* Unity
* Harmony
* Functionality
Balance:

Balance is the concept of visual equilibrium, and relates to our physical sense of balance. It is

a reconciliation of opposing forces in a composition that results in visual stability. Most
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successful compositions achieve balance in one of two ways: symmetrically or

asymmetrically
Proportion:

Proportion involves the relationship of size between objects. Proportion is also relative sizes
of surface areas of different colors in a room. The proportion of color areas such as on a wall
of a living room may be chosen to be visually pleasing. Proportion also depends on
functionality of object. For example, for the best proportion between a room and furniture, the

sizes of furniture depends on the size of the room
Rhythm:

The recurrence of elements within a piece: colors, lines, shapes, values, etc. Any element
that occurs is generally echoed, often with some variation to keep interest. Rhythm is a

repeating pattern like four identical candles space evenly apart on a book shelf.
Emphasis:

Emphasis is also referred to as point of focus, or interruption. It marks the locations in a
composition which most strongly draw the viewers’ attention. Usually there is a primary, or
main, point of emphasis, with perhaps secondary emphases in other parts of the
composition. The emphasis is usually an interruption in the fundamental pattern or movement
of the viewer’s eye through the composition, or a break in the rhythm.

Unity:

Unity refers to a sense that everything in the artwork belongs there, and makes a whole
piece. It is achieved by the use of balance, repetition and/or design harmony. Unity can be
achieved through the effective and consistent use of any of the elements, but pattern-- that is,
underlying structure-- is the most fundamental element for a strong sense of unity.

Consistency of form and color are also powerful tools that can pull a composition together.
Harmony:

Harmony is achieved through the sensitive balance of variety and unity. Color harmony may
be achieved using complementary or analogous colors. Harmony in design is similarity of
components or objects looking like these belong together. Harmony is when some or many of
the components (usually three or four objects depending on size of project or room) such as
a furniture, drapes in a room share a common trait or two. Harmony is achieved through the

sensitive balance of variety and unity.
Functionality:

A design must have good functionality. Great functionality and best possible materials for the

function usually also increases visual appeal, and prestige. Functionality is a great gauge at
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seeing how effective the design is communicating the message or purpose to the customers

or consumers in face-to-face situations.
IDENTIFY AND USE OF SKETCHING MATERIAL

It is important to identify and understand the tools

and instruments for basic hand sketching.

These are as under :

Geometry box (Set square 30,45,60,90 degree)

Pencil HB /Clutch Pencil (0.5,0.3mm) !
Drawing sheet(A4,A3,A2)

Drawing boards A2 size

Paper cutter IS

Masking Tape
Method of holding pencils

There are different ways to hold pencil for writing and sketching
but the correct method to hold the pencil for sketching task by
eliminating fatigue and stress on thumb and figure is shown in

figure.

Various types & Methods of lines (vertical & horizontal)

Lines are defined based on their orientation/direction and the angles if any, formed between

them. Generally there are four types of lines depending on angle horizontal line, vertical line,

perpendicular, and parallel lines.

e Aline that runs from left to right in a straight line is called
a horizontal line.

¢ A line that runs from top to bottom in a straight line is a
vertical line

o When two straight lines intersect (i.e. cross) each other
at right angles (= 90°), then these two lines are said to be
perpendicular to each other. Here AB and CD are the
two perpendicular lines, and they are represented as

AB_LCD

l',\
Vertical line

Horzontal Iine

. >
!

e When two lines never meet each other, no matter how much you extend them, then

these two lines are said to be parallel to each other.

e Lines AB and CD are parallel lines, and are always the same distance apart from

each other. Parallel lines are represented by the two large arrows on the lines
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PRACTICAL No. 1: DRAW AND PRACTICE VARIOUS TYPES OF LINES

Various types of hatching lines on angles

2 5 | | T/
<—e
&

e These are the combination of horizontal,
vertical or both and diagonal lines used to
create texture, value, section and the illusion
of form.

e Hatching technique work well with a variety

of different drawing mediums including pen

Q

3
¢
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&

and ink, graphite, colour pencils etc. ‘\
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PRACTICAL No. 2: DRAW AND PRACTICE VARIOU
LINE PATTERNS
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Line is considered to be basic element of art. In terms of art, line is considered to be a
moving dot. It has an endless number of uses in the creation of art. Line can control a
viewer's eye. It can describe edges. It can indicate form as well as movement. It can also
indicate value and a light source in drawing. When line is used for value or shading, we most
typically see it used in the form of hatching or cross hatching. Although these are arguably
the most common forms of using line for adding value, there is an endless number of ways
that it can be used.

Draw lines in below mention designs.

e Long, short or anything in between

e Thick, thin

e Smooth or rough

e Continuous, implied, dotted, dashed

¢ Change direction

e Change in degree of curve (curved Lines)

e Any of the above combined

/\
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A simple way of thinking of a line is to imagine a point that moves...

The most common use of line is showing where an object ends. This type of line is called

a contour line. Contour lines are most commonly

called outlines. Line can also create the illusion of
form in a drawing. Line quality is the thickness or
thinness of a line. By varying the line quality an artist

can show form in a drawing with just the use of line.

Line can also indicate shadow and form through the
use of cross contour lines. Cross contour lines follow
the contours of the object, much like running your
finger around the form of an object.

PRACTICAL No. 3: DRAW AND PRACTICE THE PATTERNS WITH VARIATION

OF LINES

Practice on free hand sketching of different
objects as per designs of the article or in the

pictures.
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PRACTICE No. 4: SKETCH ANY TWO OBJECTS AROUND YOU

Perform free hand sketching of any two object such as; cup, chair, leaf or any jewellery article

around you while following the below mentioned nine sketching techniques.

Sketching and drawing techniques

Hatching and cross hatching. Hatching is
one of the most basic drawing techniques.

Tonal sketching. Unlike hatching and cross
hatching, the tonal approach has no visible
lines.

Keep your paper smudge free with another ..

sheet of paper

Blending.
Accent lines.

Use your eraser to define form.

Nine (9) Sketching Techniques:

When you're beginning to learn in drawing, picking up a pencil is generally the first thing you

do. But, that's where many of us stop; we learn how to doodle, but don't go beyond the

basics. If you're unfamiliar with drawing with a pencil—beyond stick figures or scribbles, there
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are sketch techniques that you need to know. We will go over nine of them that will get you
well on your way to more advanced drawings.
Choosing the right materials
1. Before you start, learn about graphite.

Graphite comes in a variety of scales. Did you ever
notice that your standard pencil says HB? That's not
arbitrary. It refers to the density of the lead. A pencil
that says "H" is going to be harder and will therefore
make lighter, crisper lines. Alternatively, a "B"

indicates that the graphite is soft, and it's perfect for
drawing deep, rich darks. So, HB is right in the middle. For sketching, it's important to have a
range of pencils.
2. Paper is important.

Like graphite, your paper choices are seemingly
endless. It can vary in tone (looking "warm" or "cool")
and texture, with a smooth finish or "toothiness."
When trying to select sketching paper, look for
something that is optimized for graphite.

3. Composition and form

To make something less daunting, start with simple
shapes. Pick a coffee mugto try out sketch
techniques. It's relatively easy to draw because it can
be easily broken down into basic shapes. Try the
same thing, pick something and study it for a couple
of minutes. Ask yourself: What are the defining

shapes? Where do they overlap? With the coffee

mug, a circle makes up the lip of the cup, and an oval makes up the body. Overlap the lines/
areas in which the shapes meet.

4. When drawing, check your angles with simple trick.
While drawing the handle of coffee mug, notice that it
was foreshortened, meaning that part of it is facing - ‘
closer to me and looks distorted. To get the angle of
the handle correct, use this trick: Hold your pencil -

and line it up to the angle that you're trying to
replicate. Then, bring your pencil directly to the

paper, without moving it. That will ensure you have
the right (pun intended) angle!
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5. Sketching approaches
Hatching and cross hatching

Hatchingis one of the most basic drawing _
techniques. To create volume and shading, draw
lines that follow the curve of a line. These lines do
not touch. Cross hatching is layered hatching,
where the lines intersect. The distance between the
lines and intersections will determine how dark an

area is.

Tonal sketching

Unlike hatching and cross hatching, the tonal
approach hasno visible lines. To do this,
sweep your pencil back and forth across the page
in a fluid motion. With this technique, pressure and
graphite scale is important. The harder you press,

the darker the tone will appear.

6. Blending
Build on the tonal technique with blending. Simply
use your finger or blending stick to create a
smooth, even surface. (Wash your hands
afterward!)

7. Accentlines

Accent lines don't necessarily build form, but they

add style to your drawing. Wood grain, for

instance, is a great example of decorative accent lines you can incorporate.

8. Use your eraser to define form
Highlights are a great way to define and build
form. Bright, crisp shapes will make something
look extra shiny, but this can get muddled the

way more you draw. Once you're done drawing,

use a clean eraser to bring the white of the paper
bag. Use this technique sparingly, however—you

don't want your drawing to look fake!
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9. Keep your paper smudge free with
another sheet of paper
It seems counter intuitive, but this really works. To
avoid smudging your artwork as you draw, place
of piece of paper on top of your drawing. Rest

your hand on it while you sketch
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LEARNING UNIT 2: DRAW TECHNICAL DRAWINGS OF JEWELLERY ARTICLES
Objectives:

In this learning unit you will learn the construction of technical drawing of various jewellery
articles by developing fundamental shapes and forms. The trainee will be able to understand
the use of Jewellery measuring instruments by following international measuring systems for
gems and jewellery. The creation of perspective, isometric, orthographic and three (3)
dimensional views will help to have better understanding of manufacturing and wearabilty of
rings, pendants, earrings etc.

LEARNING OUTCOMES:

The trainee will be able to:
e Analyze jewellery article on measurements

o Draw three views of the jewellery article
e Draw cross sections.

e Mark dimensions on the drawing

o Add design elements to three views.

e Draw drawing panel.
BASIC CONCEPTS:
Difference between Jewellery Motif & Article

Jewellery Motif:

It is defined as a recurrent of image, idea or symbol that

develops or explains the theme.
Jewellery Article:

It is defined as a combination of motives in repetitive \\
S\

' \)
order with or without moving links that shows functional, "_‘ i

esthetic and wearable features.

Module 1 PREPARE DRAWING OF BASIC JEWELLERY ARTICLE MANU
Page | 19



PRACTICAL No. 1: DRAW ANY TWO JEWELLERY ARTICLES ON SCALE
International Measuring Systems
Before starting drawing any figure in Matrix we must be aware of international measuring

systems and units used in the Jewellery CAD software.

EASURE SYSTEM DISTANCE (Length) WEIGHT

Kilometer, Meter, Centimeter, | Kilogram, Gram, Milligram

American System (S.) Millimeter carat

British System (B.S) Miles, Yard, Foot, Inch Pounds , Ounce

Few conversion factors are: 1 inch = 25.4 mm, 10 mm = 1cm, 1gm =5 Carat
Jewellery Measuring Instruments and Gauges

The measuring instruments are as under:

e Steel Rule
o Wire Gauge
e Vernier Caliper

INTERMAL
o JAWS

( J
—\
\

METRICINCH LOCKING
BUTTON SCREW

LCODISPLAY _—~ SCALE

T

(e TasdiaaaneTaR2atee el 8y VRyan
-
7
/

ZERO DEPTH MEASURING
ON/OFF  SETTING BLADE

£
B
i
E

; '|I
EXTERNAL
JAWS

Geometrical shapes

The geometrical shapes can

be drawn manually by using

Square
geometry box at accurate Hexagon Octagon
angles. The 2D geometrical

shapes are also called as 2-

D Primitives shapes. Few

) ) Rectangle
basic 2d shapes namely as Triangle

rectangle, circle, ellipse,

triangle, Square and other polygons, pentagon and hexagon.
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Use of geometry tool set

The following instruments are used to draw accurate
geometrical figures .These include ruler, dividers,

protractor, set squares, compass, T-square etc.

Gemstone shapes and cuts

Gemstones may come in a variety of shapes, such as

round, pear, square, octagon, oval, heart, and triangular, among many others. Each of

these shapes may be fashioned into many different cuts, depending on the jeweler's choice

of exposing the gemstone's many facets. There shapes are as under:

\Ts=<1/

@

PRINCESS

EMERALD

MARQUISE

Wear-ability parameters of jewellery designs

Wear-ability is an essential and core aspect of jewellery article which depends upon the

following parameters.

e Design balance and proportion

e Attractive aesthetic look

e Free of pointed and sharp edges
e Fine finishing

o Adequate Weight

o Adequate size
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Orthographic (3D) projections of jewellery elements

The type of drawing in which parallel projection is used for the preparation of the drawing of
an object. These lines are perpendicular to the plane. In this drawing, it is assumed that the
object is at infinity. The shape of an object is seen in actual size in such drawing. A plane is
an imaginary surface on which pictures are prepared imaginably. Then it is transferred to the

paper. This plane is faced toward the object whose view is to be prepared.

Front Right Side

R 3D Representation I 2D Orthographic Projection

Generally, three views of an object are prepared. These are Top View, Front View, and Side

View.
1. Front View:

This view is prepared by placing the object in front. The length and height of an object are

shown in this view.
2. Top View:

This view is prepared by looking to the object from the upper side. The length and breadth of

the object are shown in it.
3. Side View:

This view is prepared by looking to the object from the right side or left side. The breadth and
height of the object are shown in it.

aview (1)

.................

) I e B e
cviEw |
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Dimensioning _I—

It is defined as the process of measurement of an

object either linearly, aligned, diametrically or radially.

small space

Types of Dimensioning
1. Parallel Dimensioning

Parallel dimensioning consists of several dimensions

originating from one projection line.

2. Superimposed Running Dimensions

Superimposed running dimensioning simplifies parallel
dimensions in order to reduce the space used on a drawing.
The common origin for the dimension lines is indicated by a
small circle at the intersection of the first dimension and the

projection line.

3. Chain Dimensioning

Chain dimensioning simplifies parallel dimensions in order to

reduce the space used on a drawing.
4. Combined Dimensions

A combined dimension uses both chain and parallel

dimensioning.

Dimensioning of circles

(@) Shows two common methods of
dimensioning a circle. One method

dimensions the circle between two lines

projected from two diametrically

opposite points. The second method _ 2100

/
45 h"""projectl‘on ling
\short extension
I

U=

CEuril eyt

A, Ao

2550
5100

dimensions the circle internally. |

(b) is used when the circle is too small

for the dimension to be easily read if it (@

was placed inside the circle.
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Dimensioning Radii

All radial dimensions are preceded by the capital R.

e (a) Shows a radius dimensioned with the centre

RS

of the radius located on the drawing. R5 \
e (b) Shows how to dimension radii which do not R15
need their centres locating. (a) (b)
Page setup
Drawing
—> | |
A ¢
A
v =
Number
v I Designer Name Title of Work Date
< > < > < > ———»

P
<«

v

ANGLE OF PROJECTIONS & PERSPECTIVE VIEWS (1-POINT & 2-POINT)

Perspective definition

e The art of picturing objects or a scene in such a way, e.g., by converging lines (linear

perspective), as to show them as they appear to the eye with reference to relative

distance or depth

e the appearance of objects or scenes as determined by their relative distance and

positions
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¢ the effect of relative distance and position

One-point perspective

In one-point perspective, all lines converge to a single

point on the horizon.

1

1 PARALLEL VERTICALS
—
1

LINES CF
1 PERSPECTIVE

_,T___E,,A\ 1

1
|
|
|
T
|
1
I
I
|

1
1 1
il ! =
HORIZON LINE
A ’
1 1 '
1 1 '

Ll

SINGLE POINT
PERSPECTIVE

| |
ONE VANISHING POINT

Two-point perspective

The type of perspective in which parallel lines along
the width and depth of an object are represented as
meeting at two separate points on the horizon that
are 90 degrees apart as measured from the
common intersection of the lines of projection
Two-point  perspective addresses the drawing
issues we face rendering our subject from the side,
where horizontal lines converge to two points on

the horizon

Ref :https://www.handprint.com/HP/WCL/perspect3.html
https://en.wikipedia.org/wiki/Perspective (graphica)#On
e-point_perspective
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Isometric View and Projection

Isometric projection is a two-dimensional representation for viewing a three-dimensional
object with the three primary lines equally tilted away from the viewer. The angles to draw the
isometric projections are 30 and 60 degree.

RIGHT SIDE TRONTVIEW
View #
i 4
= et
— |
o=
vitw 2
1 )
%]
*FIRST ANGLE PROJECTION METHOD e

Orthographic Views Isometric View Realistic View
Multiple 2D Views One 3D View
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Frequently Asked Questions
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Test Yourself (Multiple Choice Questions)
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Introduction
The learner guide for Gems and Jewellery sector of “Jewellery CAD/CAM” will provide an

insight to the development of the Gem and Jewellery industry on modern means of
technological advancements. It will provide an opportunity to the learner in better
understanding of the use of Jewellery CAD/CAM software in providing state of the art
solutions to the customers. A special care is observed in designing the learner guide to bring
an easy solution in understanding with examples and practical exercises for your first time
users and also it will bring a lot learning opportunities for the mid-career workers in the
sector. Programme is to engage young people with a programme of development that will
provide them with the knowledge, skills and understanding in working as a well
professionally groomed worker or even starting own venture as an entrepreneur. The
programme has been developed to address specific issues, such as the national, regional
and local cultures, the manpower availability within the country, and meeting and the
exceeding needs and expectations of their customers. The main elements of your Teaching

and Learning Material are:

Introduction:

This includes a brief description of your guide and guidelines for you to use it effectively.
Modules:

The modules form the sections in your Teaching and Learning Material.

Learning Units:

Learning Units are the main sections within each module

Learning outcomes:

Learning outcomes of each learning units are taken from the curriculum document

Learning Elements:

This is the main content of your Teaching and Learning Material with detail of the knowledge
and skills (practical activities, projects, assignments, practices etc.) you will require achieving
learning outcomes stated in the curriculum.

This section will include examples, photographs and illustrations relating to each learning
outcome

Summary of modules:

This contains the summary of the modules that make up your Teaching and Learning
Material

Frequently asked questions:

These have been added to provide further explanation and clarity on some of the difficult
concepts and areas. This further helps you in preparing for your assessment.

Multiple choice questions for self-test:
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o These are provided as an exercise at the end of your Teaching and Learning Material to help

you in preparing for your assessment.
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MODULE: 2 CREATE COMPUTER AIDED DRAWING OF BASIC LEVEL JEWELLERY

OBJECTIVE:

The purpose of this module is to enable the trainee in understanding the importance and role of CAD/CAM in jewellery field. Furthermore it
describes the use of setup interface of jewellery CAD software, creating 2D drawings, designing of simple jewellery article along with its

presentation.

MODULE SUMMARY

This module is an essential milestone in designing and understanding of the fundamentals of jewellery article on computer aided software at
basic level. It will cover the basic elements and principles of design that how trainee will transfer ideas in to practical jewellery article on CAD
software. Furthermore it emphasizes the designing of jewellery article conceptually following manufacturing techniques to produce jewellery
article with precision and accuracy. It covers the Setup interface of Jewellery CAD software, creating 2D and 3D drawings and to perform Basic
level Rendering.

The course learning units are arranged in such a way to integrate concepts and ideas related to each topic through tools and application-
oriented projects. This makes the learning simple and systematic and enables one to gain more insight knowledge on the various tools

covered.

LEARNING UNIT 1: SETUP INTERFACE OF JEWELLERY CAD SOFTWARE
LEARNING OUTCOMES
You will be able to:

¢ Analyze jewellery article on measurements (Rings, Earing, Bangles and Pendants).
e Set up canvas in CAD Jewellery software.

e Scan and import image of manual 2D drawing if required
MATERIALS REQUIRED

e Computer Machine as per software compatible
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Operating system (Windows Pack)

Jewellery Design Software (Rhinoceros 3D & Matrix)
Steel Ruler

Ring Sizer

Vernier Caliper

LEARNING UNIT 2: CREATE 2D DRAWINGS

LEARNING OUTCOMES
You will be able to:

Draw three views of the jewellery article
Mark dimensions on the drawing

Add design elements to three views.
Draw cross sections

MATERIALS REQUIRED

Computer Machine as per software compatible
Operating system (Windows Pack)

Jewellery Design Software (Rhinoceros 3D & Matrix)
Digital Vernier Callipers

Steel Rule

Wire Gauge

Ring Sizer

Bangle Sizer

Module 2 CREATE COMPUTER AIDED DRAWING OF BASIC LEVEL JEWELLERY

Page | 4



LEARNING UNIT 3: CREATE 3D DRAWINGS

LEARNING OUTCOMES
You will be able to:
o Generate 3D surface using profiles, cross sections etc.

e Place simple design components (Gemstone, metal inserts etc.) on jewellery article if required.
e Assign material to 3D model and calculate weight of jewellery article and its components

MATERIALS REQUIRED

e Machine as per software compatible

Operating system (Windows Pack)

o Jewellery Design Software (Rhinoceros 3D & Matrix)
o Digital Vernier Callipers

e Steel Rule

o Wire Gauge

¢ Ring Sizer

e Bangle Sizer

LEARNING UNIT 4: PERFORM BASIC LEVEL RENDERING

LEARNING OUTCOMES
You will be able to:
o Prepare 3D model for presentation.

Module 2 CREATE COMPUTER AIDED DRAWING OF BASIC LEVEL JEWELLERY Page | 5



e Apply pre-set parameters as per environment
¢ Render 3D model

MATERIALS REQUIRED

Machine as per software compatible

e Operating system (Windows Pack)

e Jewellery Design Software (Rhinoceros 3D & Matrix)
e Paper Printer (Colour)

e Steel Rule

e Paper cutter

e Ring Filer
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BASIC CONCEPTS
CAD/CAM has become a necessary tool in designing and manufacturing of jewellery. It emphasizes the creation of conceptual jewellery both
qualitatively and quantitatively. Candidates will learn to translate concepts into creative patterns by using CAD software. It will develop creative

and technical skills to enhance designing and manufacturing capabilities.
COMPUTER AIDED JEWELLERY DESIGNING (CAD) g B
CAD is defined as effective and efficient use of computers to assist the design process. Computer-
aided designing involves the use of computer systems to assist in the creation, modification,
analysis, or optimization of a design.

COMPUTER AIDED JEWELLERY MANUFACTURING (CAM)

Computer Aided Jewellery Manufacturing (CAM) is the manufacturing process of jewellery article

based on the modern techniques on computer. It involves the integration of CAD engineering data

and the computerized equipment which manufactures the jewellery products. Computer aided

manufacturing is “the use of computers for managing manufacturing processes.”

CAD / CAM (computer-aided design and computer-aided manufacturing) is a term that refers to computer systems that are used to both design
and manufacture of jewellery products. CAM system takes a CAD design made in a 3D environment. CAD design is then manipulated
according to defined parameters and resulting information is fed to CAM Machine. CAM Machine then starts working on stack. These machines
are controlled by computer with minimal operator’s interaction to enhance and facilitate greater control over quality. It also allows machine to

monitor the maintenance of its parts
TYPES OF CAM MACHINES
There are mainly two (2) types of CAM machines.

1. CNC Machine (Computer Numerically Controlled)
2. RP Machine (Rapid Prototype)

Module 2 CREATE COMPUTER AIDED DRAWING OF BASIC LEVEL JEWELLERY Page | 7



ROLE OF CAD /CAM IN JEWELLERY

The jewellery industry uses computer-aided design (CAD) and computer
aided modeling (CAM) technology for designing, drafting and tracing of a
jewellery motive. CAD/CAM software systems are capable to present 3D
solid and surface models. These software can also frequently allow rotations

in three dimensions, allowing viewing of a designed object from any desired

angle, even from the inside looking out. CAD/CAM is used in the model

design of complex creations of jewellery as well as in simple patterns.

CAD/CAM has become an especially important technology within the scope
of computer-aided technologies, with benefits such as lower product
development costs and a greatly shortened design cycle. CAD/CAM enables
designers to layout and develops work on screen, print it and save it for

future editing, saving time on their drawings

SIGNIFICANCE OF CAD/CAM IN JEWELLERY
CAD/CAM software is much more efficient in modeling for Jewellery products

e The output for RP is much accurate and precise

o Experienced users of CAD software can spend 3-5 times less time in manual designing and drafting of jewellery article.
e Users can model a design with less time if they are familiar with basic CAD.

o These software have additional useful time efficient functions for jewellery designing and making

e These software have extensive built in library for jewellery modeling

e Interms of price & production performance, CAD software will be more justified to use
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STRENGTH OF CAD

CAD Software can deliver powerful, easy, artistic tools,
including the ability to create a 3D model directly from a digital
image. Scan in a photo, and Software will create an organic,
sculpted piece using the highlights and shadows as guidelines
for height.

Drafting using computers became a reality when graphics
were added (CAD used to mean computer aided drafting).

From Picture to Sculpture look into the picture.

REQUIREMENT OF COMPUTER MACHINE FOR JEWELLERY CAD SOFTWARE.

The following Specification of Computer Machine required as per jewellery CAD software Matrix 8.0 and Rhinoceros 5.0

Specifications

Minimum Requirement

Specifications

Minimum Requirement

Processor Speed

Minimum Core i5

Operating system

MS-Windows 7

(Recommended Windows 10)

RAM Minimum 8 GB Rhinoceros 5.0
Software (Jewellery Dedicated)

Hard Disk Minimum 500 GB Matrix 8.0

VGA Card NVIDIA 1GB
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GRAPHICAL INTERFACE OF JEWELLERY DESIGN SOFTWARE (GEMVISION MATRIX)

) Matrix 8.0 (64-bit) -

File Edit Yiew Curve Surface Solid Mesh n Transform  Tools Analyze Render Rhino 5.0 Blend T-Splines Help
| ICON HISTORY

«‘110" ] .,)T‘ 2 FF
| MAIN MENU Reload

View Utilities Measure Cus™Neg
® Curve » Surface » Solid ® Transform e
» Builder » Tools ®» Gems #» Setting ® Cutters »

B> « » =5 =

Status/ Command Bar
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MENU ‘S DESCRIPTION

Flle Edit Vlew Cuwe Surface Solid Mesh Dlmensmn Transform  Tools Analyze Render

Main Pull Down Rhino Menu

History Menu

® " arve » Surface » Solid ® Transform ® Targets ® Art
/ » Builder » Tools ® Gems # Setting ® Cutters ®Rende

Matrix Main Menu

Top 11 Tools Menu

Osnap Menu

Information Menu

[Hide ® | [Show @

User 01 |

User 02 [)
User 03 [¥
User 04 [)

Heads

Layer Menu

Finger
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COORDINATE REFERENCE AXIS:

X, Y and Z are reference axis used to specify and construct the required object on Grid.

These X, Y and Z axis are at 90 degree to each other.

GRID

e Grid or graph is comprised of equal horizontal

and vertical lines to construct any object on
actual scale.

e The smallest box is of 1-mm and large box is
of 05 —mm.

e The 40x40mm grid is broken into 1 x 1 mm
squares indicated by the light grid lines and 5
X 5 mm squares indicated by the LIGHTER

grid lines.

Through Finger Side View
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ANALYZE JEWELLERY ARTICLE ON MEASUREMENTS

e First of all we have to analyze the
jewellery article from all views

e Then we have to note its critical

dimensions/ gauges by wusing the
following tools.

Measuring Tools
e Steel Ruler
e Ring Sizer

e Vernier Caliper
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CRITICAL DIMENSIONS

»45
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Module 2 CREATE COMPUTER AIDED DRAWING OF BASIC LEVEL JEWELLERY

Page | 14




RING SIZER

—l
14mm nm mem 152 mm 156m 1
¢ 3. ¢ \ ¢ N < N, ¢ \ ¢
> < > < < s < s < s <
645 6 n 173 177 mem Ly 186
. ¢ N ¢ N ¢ \ ¢ \ l
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— = —— —— =<
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INTERNATIONAL RING SIZE CHART

Material Thickness
s Metric Deameter Cirtam. 10 ga. 1% ga. 14 ga. 16 ga. 1B ga. 20 ga.
RingSize RingSize (mm} (mm) 26mm 24mm 22mm 2ZImm 20mm 1Bmm 1Emm l14mm 13mm 12mm 1.0mm O0Bmm
1 R0 12.4 70 471 465 459 456 457 FLT. 440 434 430 427 4z.1 41.5
1 402 12.5 402 454 478 47.1 458 455 459 452 444 443 440 43.4 4.7
2 41.5 132 415 494 490 454 48.1 4ATB 47.1 6.5 459 454 452 446 440
2 27 13.6 427 5q0g £03 495 493 490 454 47.B 47.1 46.8 46.5 459 452
3 4.0 14.0 440 23 515 1k 504 503 495 490 A3.4 4a.1 478 471 46.5
By 452 14.4 452 E34 E2B E2 D ELB LY L4k 50.3 0.4 403 490 484 478
4 A5 148 445 BT BAD 34 53l 528 522 51.5 509 50.4 503 4,25 45.0
4]y 47.8 15.2 478 59 55.3 547 543 540 534 528 522 518 515 509 503
6 220 15.6 420 L E&5 59 556 5543 AT 540 534 531 528 523 = B
6 50.3 14.0 50.3 554 ETR Er2 &9 545 559 55.3 547 543 540 53.4 2.8
& 51.5 14.4 515 ;7 581 564 5&.1 5TR 572 56.5 559 554 55.3 547 340
6y 528 148 528 09 &0.3 587 584 581 584 578 572 569 56.5 559 5.3
7 54.0 17.2 540 22 14 09 806 £0.3 L lrd 59.1 58.4 5.1 S5THR 572 56.5
T'fs 55.3 17.6 553 £3.5 £28 22 &% &5 07 403 507 504 58.1 58.4 ST.E
8 5&.6 1a.0 545 AT &4 35 &3 28 22 &b &0% a0 a0.3 597 G381
B[y 57.8 13.4 578 &0 £5.3 &7 &4 &4.1 £3.5 A28 &2.2 YR &4 &0F &0.3
9 5.1 148 59.1 &7 LT 610 57 53 &aT LR 635 431 428 a2 2 &lb
L AT 50,3 19.2 &0.3 £5.5 &9 &7.2 40 LET &40 453 &A.7 a4 44,1 435 428
10 61.6 19.6 a1 il &3] 86,5 6.2 679 872 B6A &6.0 a57 853 &4.7 &4.1
10, G628 0.0 a2 71.0 70.4 8.7 0.4 £9.1 &6.5 &7.9 &7.2 86.9 865 &850 693
11 6.1 0.4 &1 23 T4 71.0 mr 704 &7 881 &85 482 4TS a7.2 Gb.b
11%: 653 205 #5.3 735 29 723 ) ] 716 710 70.4 an.7 ¥ a9.1 &85 ars
12 666 71.2 Y 748 741 735 732 29 723 714 710 0.7 70.4 &7 &9.1
12'; 679 214 4TS 760 75.4 748 745 741 735 729 723 719 714 710 704
13 9.1 72.0 &5 73 76T THO 75T 754 748 74.1 735 732 729 723 716
13 713 2.7 71.3 ™5 7aR 7az e 7A 770 76.3 75.7 754 75.1 745 73R
14 726 21.1 726 BO.7 BO.1 .5 ™2 78R TR.2 7TA 770 767 76.3 757 751
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SET UP OF COMMANDS FOR BASIC JEWELLERY ARTICLE
TO MAKE A SIMPLE BAND: The following command/ tools are used to create a simple band.

Fy
Ring Rail B¥® Profile Placer Sweep 1 History

LEARNING UNIT 2: CREATE 2D DRAWING

Through Finger

Take a Ring rail (circle). =
Click on to Tools Menu ( )
Click Rail Ring »Tools = Ring Rail

Assign finger size inmm :...... then click function
RING {—:], -
RAIL L 7

Click Profile Placer
e Load Ring Rail in vacant curve window
o This will show a profile placer along circumference of the ring rail.
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Adjust the following parameters
e Width =3 mm
e Height=2.5mm

Add Mot
WIDTH :

Second Rad

—t

LEARNING UNIT 3: CREATE 3D DRAWING

e Go to surface Menu
e Click “Sweep 17 it will ask: I Sweep 1 il Options
e Select Ring Rail : click on Ring rail in Front view g— =
e Select cross section : click Profile placer Dowetmer
e Then press Enter o e
Cross-section curve options
® Then press OK.
° g:::ultds:liw 3 control points
() Refit within 0.001 milimeters

QK ” Cancel ][ Preview H Help ]
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Through Finger
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PRACTICAL 01: Create an Open Shank Band or Ring by using Simple Sweep: (Reference:
Gemvision Matrix Manual)

Create a basic ring with a ring rail, profiles and sweep function.

Learn to use the Ring Rail and Profile Placer tools to draw a simple ring at the desired ring size.

Practice adjusting the profiles (also known as cross-section curves) that make up this ring to

create a tapered shank. Then, use Sweep 1 with History to complete the shank.

~ Ring Rail '3 Profile Placer Sweep 1 History . Cap Planar
() % =~
- ‘ T m

PRACTICAL 02: CREATE 2D DRAWINGS

1. BEGIN WITH RING RAIL

Click on the Tools fly-out menu and select the Ring Rail tool. Select a Size 7 ring rail from the
drop down menu and click on the green arrow button to place it in the viewports

2. ADD TO PROFILE PLACER
Open the Profile Placer builder, also found in the Tools fly-out menu, and select the rail curve that
was already placed in the viewports, clicking on it once so that it is highlighted in pink. Click on the

in arrow beneath the Curve preview window in the Profile Placer builder and the curve will appear in

the box. Now it is ready for a profile!
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3. PROFILES AND VCH

You'll notice a default DOME profile has already appeared in the view port on the Ring Rail. Included
with the profile are a variety of controls that will scale, move and rotate the profiles. These are called
Viewport Control Handles (VCH).

4. PROFILE PLACER MENU

A series of graphics and an Interactive Control slider bar (IC controls) are also available under the Profile
Placer menu for editing capabilities. When you click on the builder menu graphic representing the
dimension you wish to change (Width, shown above), the slider control will change to that dimension,

allowing you to adjust it.

5. Editing & Adding Profiles

To adjust the IC controls, “click and drag” the slider control by left-clicking on the white cube and, holding
YIDTH :

down the left mouse button. Move the mouse left or right to drag the slider to the position needed. » ®

Release the left mouse button to set the slider. As you do this, the corresponding VCH on the screen will

turn red and identify the handle.

After editing and positioning the first profile, you may add more
profiles by clicking on the Add button. You must then click on the
Position on Curve graphic (or VCH) to re-position the additional
profile higher on the Ring Rail.
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6. Mirroring Profiles

. iy , , G . . n
With the additional profile added to the Ring Rail, click on the Add Add Mirror N % &
Mirror button in the Profile Placer menu and an identical profile will E dit ; : __"| HEIGHT : 2,64 mm
Select Ral — T
appear on the opposite side of the rail. You can again utilize either N Ao Axl: S . ~ /N "

the IC controls or the VCH to make adjustments to the height, Second Rail Z * T A
Add ’
width and location of the top profiles. Once you have them in

place, you must hit the ENTER key to set the profiles. The VCH on
the screen will disappear. Now you are ready to sweep the rail!

LU3: (PRACTICAL 1) CREATE 3D DRAWINGS

1. Sweeping the Ring (a)
Click on the Sweep 1 with History icon in the Surface flyout menu and instructions will appear in the

Command Line to Select Rail. Click on the Ring Rail in the viewports and directional arrows will appear
on the rail

2. Sweeping the Ring (b)
The Command Line will instruct you to Select Profile. You must select each profile following the direction of

the arrows (in this example, in a clockwise direction). When you have selected all three profiles, hit ENTER.
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3. Shade your model

You now have a swept surface. Right click on the Shade button and you will see a solid model in all

four view ports. Right click again to turn shade off.

4. History and F6 Key

History allows the user to make changes to many different elements of a model and receive immediate
feedback on the results of those updates. To change the profile, click on the profile curve, press F6 and a

list box will appear. Select the MSR option (Move, Scale and Rotate).

5. Changing the model

When MSR is selected, the VCH reappear, allowing you the ability to resize, move or change the profile
shape. Make the profile taller and wider using the VCH or the IC controls in the menu. When you are
finished updating the profiles, press ENTER and the ring will automatically update (or re-sweep).

To change the shape of the profile, click again on the profile curve and press F6. Select MSR from the list
box. When the VCH reappear, click on the yellow shaped icon near the handles. It will turn red when
selected. This will open the Profile Browser — a library of profile shapes to choose from. Select a new shape

by clicking on an image with your left mouse button.
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The new profile shape will appear in the viewport. You may again resize or position your new profile
shape, or simply press ENTER to accept the changes and the ring will update to a new model.

6. Selecting a model

In order to save your model, you must first select it. There are two methods to select objects on the screen. The first is called Region Selecting.
To region select, click and drag the mouse from the upper left-hand corner of a model down to the lower right-hand corner of the model to

draw a selection box around it. Region Selecting — Solid line
When using this technique, you MUST SURROUND the ENTIRE MODEL with the selection box!!
**This selection method is denoted by a solid line.

Note: The model will change to a bright pink color when selected.

The second method is called Crossing. To select a model with this method, simply click and drag the

mouse from the upper right-hand corner of the model down toward the lower left-hand corner. When
using this technique, ANYTHING YOU CROSS with the selection box will be highlighted during the Crossing — Dotted line
selection!! In other words, the item need not be surrounded by the box: it needs to just be touched or

“crossed” by the box in order to be selected.

**This selection method is denoted by a dotted line.
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7. Saving Models

PROJECT MANAGER

Save this model by using the Project Manager. To begin, select the model using one of the
methods described. With the model selected, click on the white “IN” arrow beneath an open Job
Bag.

Do NOT put an object into a job bag that is already full (has a preview in it), or else you will

overwrite the contents of that job bag, and you will not be able to get them back. Only put an object

into an empty job bag, unless you are POSITIVE you don’t need the contents of the job bag you are

going to overwrite!!

8. Deleting the Mesh

Now click on just the green wire frame surface of the model, highlighting it, and press Delete on
your keyboard. This will leave just the rail (peach colored) and profiles (yellow) that you placed

there earlier.

9. Open Sweep

We’'re now going to do what is known as an open sweep. Click on the Sweep 1 with History button found in the
Surface fly-out menu. Now, click on the ring rail to select it. Then, working in the sequence shown above, click
on each profile, working your way from the upper right, down and around to the upper left, of the ring. Select

each one, then refer to the Command Line above the view ports. An option is listed there titled “Closed = Yes.”
Click on that option and it will change to “Closed = No.” m Press ENTER.
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Before Cap Planar: After Cap Planar:

The result is an smm  OpEN shank. When the open sweep appears, select the

e

surface and click on Cap Planar found in the Solids menu to create a solid ring.

Select this item and Job Bag it as well.

10. Profile Cap

Another option to cap the ends of your open shank is Profile Cap. Instead of using Cap Planar, simply
click one of the open profiles at the top of the shank and press F6. The list box will appear, offering a
choice between MSR and Profile Cap. Choose Profile Cap.

An end cap will appear with a white, cone shaped control
handle. Click and hold the handle with your left mouse button
and pull away from the end of the shank. A round, blended
cap will appear at the end of the shank! Pull it to the length
you desire, but be sure to make a note of the length you
assigned and follow the same steps for the other end of the

shank. Press Enter to set it. Be sure to Job Bag your model.
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If you decide to make any changes to the details of your shank, such as the shape, size or location of

your top profiles, you can do so without affecting the end caps. Since History is present, your end caps

will recalculate and blend according to the changes you make.

With two end caps on your shank, you now have three open surfaces: the shank and both end caps.

In order for these to become one, solid shank, you will need to select everything and click on the Join tool.

Perspective Through Finger
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FOLLOW GEMVISION BASIC MANUAL FOR CURVE MENU EXERCISE
PRACTICAL 3: Tracing Technique of Bitmaps Image File
LU1L: Create 1D Drawings
Import images into Matrix and trace the objects for a variety of design uses.

Learn to place a background bitmap in the viewports and trace it with Curve tools, creating a closed curve.

Use the Edit Points or Control Points commands to fine-tune the shape once you are done.

. Control

. Place - Interp Edit 0.n ro

Ej Background ra . Points
= Curve Points

Hide Show Remove
Background Background

Background
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ﬂ Find the File

Open Bitmap

H Look 2 Pxhuae
It 1S Very easy to (3 My Recert Documernts

. . A 3 Deskicp
bring a bitmap L ‘)J_.,.,:f_. .

Decimes oL Meae
image into Matrix. y - ) Demos
Ptues

©

fresh viewport by clicking on File and New. Go to the

g My Comrputer [~'

First, start with a

View fly-out menu. Click on the Place Background

Bitmap icon. The e
bitmap  file is
located in My
Documents >

Matrix6 > Demos >

Curves folder.

Select the files called “The M” and click to open.

Bring the Image Out
You

2

Looking Down

will now be ‘ir‘;gr
prompted to ] ;5’, 'I}'
create  a V4 ;

- e SV A V4
rectangle in AmEy iy
the Looking e

Down viewport that will tell Matrix where you
want the Background Bitmap to be placed. The
Command line at the top of your screen should
now say “First Corner”. In the Looking Down
viewport, click your left mouse button wherever
you'd like to position the first corner of your

bitmap.

Then it will say “Second corner
or length:” in the Command
Pull

diagonal

Line. the cursor in a
direction (Opposite
corner) until you arrive at the
desired size. Click the mouse
one more time to position your
bitmap. The M will appear in

the viewport
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Tracing the Image “‘]

Now, using the Interp Curve tool, trace the “M”. It is a good idea to turn your Grid Snaps OFF at this point so that you can follow the curve of
the “M” faithfully. Each time you click, you create an edit point. Space these points closer together to create tight curves and leave more space
between each for gradual curves. Trace com- pletely until you reach the start point.

Edit Points

When your tracing is completed, remember that you can edit an Interp Curve using Edit Points or Control Points. Edit Points allows you to
move each edit point independently. You can highlight several points if you wish to move them as a group.

Control Points

Control Points allows you to control the steepness of the curve. When you’re done adjusting your curve with these commands, you have to tell
Matrix to stop the command. This is done by hitting the Escape key twice.

Looking Down

Looking Down

Hide Click on Hide Background Bitmap in the View fly-out menu to check your work. This temporarily removes the bitmap — revealing
only your curve. And Show If you Hide your Bitmap, it is similar to “turning out the lights”. You must remember to click on Show

Background to turn the lights (or image) back ON. If you try to Place another Background Bitmap in your viewports and Hide Background

is still active, it will never appear on the screen!

Remove Background

Be sure to Job Bag your work! Only AFTER you have done so should you click on Remove Background. This will permanently remove the
bitmap from the screen. Even Undo will not bring it back, so be certain you are finished
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TYPES GEM SETTING
The most common types of gem settings are as under

e Prong/ Claw
e Bezel
1-PRONG/ CLAW SETTING
It is defined as a combination of three(3) or four (4) prongs that hold the

stone in place. This type of setting exposes the maximum amount of light
to the sides and bottom.

2. BEZEL SETTING

In this type of setting a vertical strip of metal is formed to encircle the stone, and then soldered to a metal base. The stone is secured by
pushing and bending the bezel towards the stone using a burnishing tool.

Cross-Section Cverhead
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GEMS ANATOMY

DEFINITION OF GEM (JEWEL)
A Jewel is referred as precious stone; a Gem ,_I_l

CROWN —-/ ﬁ- lr- Main lacels

Table

GIRDLE -—"*_ Break facets

Break facets

PAVILION e
Main facets
Culat
GEMS SHAPES WITH RESPECT TO CUT

\Ts=T/ 2T

¥ | |
:" sty
PRINCESS RADIANT CUSHION

PV
EMERALD PEAR MARQUISE HEART
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PRACTICAL: 3 Copy, Move, Rotate and Mirror
Create a three-stone head design using the techniques listed below.

Practice using the Copy, Rotate, and Mirror commands to create a three-stone head design. Mid- and

End- O-Snaps assist in this tutorial, as well.

Icon Key:

E Copy .E Move EndO-Snaps Mid O-Snaps - Rotate
“ Mirror

1. Open File =

Through Finger

Click on the Open icon in the File fly out menu. In the Matrix folder found in “My Documents”, click on
the Models folder and open up the Copy, Move, Rotate, Mirror tutorial to see it in the viewports. We

will begin by copying this bezel so that we can start arranging our design..

2. Duplicate Bezel

Go to the Duplicate command and click on it. The Command line
says “Select objects to copy:” Highlight the bezel and the gem in the
Through Finger viewport and press Enter. The prompt now reads:
“Point to copy from:” Matrix needs a reference and at this point it is

at the center of the grid. That location has been mapped to a pacific
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shortcut key which is F4. This is called “The Center of the Universe.” From the Looking Down view, press F4. A second bezel will appear in the
viewport. To place the second bezel straight out from the first; simply move the mouse the right. To keep it on the same plane, you must also

hold down the shift key to engage Ortho. Click once on your left mouse button to set the second bezel in place.

3. Move Bezel and Gem

| Looking Down Looking Down Through Finger

Highlight the second bezel and the
gem in the Through Finger viewport

and press Enter. The prompt now

reads: “Point to copy from:” We want to
shap to the Mid O-Snap on the left side of the selected bezel. When the Mid-point appears, click your left mouse button once. You are now
holding the gem and bezel from that point to be repositioned. The prompt now reads: “Point to move to:” With the mouse, drag the bezel and
gem toward the other bezel. You will need to snap to the End O-Snap of the center bezel. When the End point appears, click the left mouse

button and the two bezels will be precisely connected at those points.

4. Rotate Bezel and Gem Through Finger

Go to Rotate. When the Command line prompts you to “Select
objects to rotate:” highlight the bezel on the right. Press Enter. The
prompt is now looking for the “Center of rotation:” We want to rotate

this so that the two bezels are flush on the sides. Snap to the top left

of the bezel on the right. When the Command line prompts you for the

“Angle or first reference point:” snap to the bottom left of the same bezel, which is the Mid O-Snap Now the prompt reads “Second u reference
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point:.” You'll notice as you move your mouse across the screen that it will spin the bezel until you click your mouse button again. Snap to the

bottom left of the bezel on the left to finish the Rotate command.

5. Mirror
Now we want to copy this bezel over to the other side. Go to Mirror,
select the rotated bezel and press Enter when the Command line

prompts En you to “Select object to mirror:” When prompted for the

“Start of mirror plane:” select F4 in the Through Finger viewport.

Holding the Shift key down, move your mouse up over top of the bezel
and click once to indicate the “End of mirror plane:” This is what it should look like.

Render of completed head assembly

Be sure to Job Bag this.
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SAVING OF CAD MODEL IN A FILE:

There are two methods of saving a CAD file

Method 1:

First go “file Menu” Click on “Save as” The file extension of CAD file is *.3DM. Its abbreviation is

as follows
3D 3 Dimension
M Model

File View Utilities Measure Custom Reset

® Curve » Surface » Solid » Transform ® Targets ® Art

»» Builder » Tools ® Gems » Setting ® Cutters ® Rende
wr

y m=

B> i

e The window will open ask for the file saving path in a particular folder”

e Select the folder of your own choice

e Then give a specific name to file as “Model1”

e Then Click to “OK”

Method 2:

e The second method is to save the model in Project Manager /Job Bag.

e This can be done by selecting the model first and then upload in the menu as shown below.

e Project Manager /Job Bag is generally used for incremental saving
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}v File; Edit, View, Curve, Surface, Solid, Mesh,
IB New Ctrl+N
: kel Open Ctrl+0
F E Thumbnail Browse
Open RVOC...
H Save Ctrl+S

=N Save Small

.
Incremental Save
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CALCULATION OF METAL WEIGHT AND NUMBER OF GEMS

e The Matrix software has a strong command to check n verify the weight of solid MAIN MENU

] ] ) ) ) ) ) file View Utilities Measure Custom Reset
jewellery piece in all Karatage of gold , silver etc, along with the calculation of weight P = - —————
and number of gems used in respective jewellery piece. » Builder » Tools # Gems » Setting @ Cutters # Rende

e These commands lie in Tools Menu.

e Calculating weight of Solid Jewellery piece

| F NI

‘ Command: Metal Weight

Platinum 5% Irid
Si Pure

Highlight the item you want to find the weight for
then press go.

Calculate o
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MAIN MENU Gem On Curve
CALCULATING GEM NUMBERS AND WEIGHT IN TERMS OF CARAT: :

Yile View Utilities Measure Custom Reset
The command lies in Gem Menu named as “Gem Reporter” Curve » Surface » Solid » Transforme Targets @ Art
'Builder » Tools ®» Gems # Setting » Cutters ® Rende

e mnl

MAIN MENU |

qle View Utilities Measure Custom Reset Perspective
Curve » Surface » Solid » Transforme Targets ® Art
Builder » Tools » Gems » Setting ® Cutters ® Rende

s

'(.1
bb D@,

INFO & SETTINGS
LAYERS
PROJECTS

Total Gem Weight 151 Total Gem Count

-

Update ]T Save Report
Diamond Trillion Diamond
7.00 X 7.00 1 [1.astw

Diamond Round Diamond
1.50 X 1.50 [ 29 [0.37tw BT
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PRACTICAL: 4 TO DESIGN A PRONG SETTING RING
LU1: Setup interface of Jewelry CAD software

e Goto Tools Menu...... Load Ring Rail = 17 mm (your finger size)

e GotoGemMenu ...... Click Gem Loader

e Drag gem on the top of Ring rail by pressing Shift+ Mouse.
Note: the distance between Culet & Ring rail = Imm

4 ,'fit?;?;,z:;ﬁ:Jjevt.:;'?'ﬁi;,?:-js:rll_u:s',_'W,’:_-'_-‘;E;i: Yook ) Surtacy
W e dFVYIE AR PPD

YARSRRERR) Soe v | Tosing Down
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® Curve » Surface » Solid ®» Transform» SubD ®Art
» Builder » Tools » Gems » Setting ® Cutters ®Rende

LU2: Create 2D Drawings

b - - l\" s ) '
e Go to Setting Menu .....Click Head Builder \ S f‘;] > &'n - @ Laly, o
e Select gem and load in Gem Shadow window

e Select the respective combination of prongs :

e 2-prongs or 3 prongs or 4 —prongs , 6- prongs , 8- prongs

Adjust the prong parameters

a- Prong Size: 0.8t02.0 mm

b- Head Drop : Restrict to Ring rail top

c- Prong Nudge : Don’t change

d- Prong Dome : 1mm (or as per your design requirement)
e- Rail Drop : Adjust near to gem girdle.

f- Height above Girdle: 1.0 mm to 2.0 mm

g- Head Angle : (as per your design requirement) By Bon

V-shape = 10° Straight =0° A-shape =-10°
h- Top Angle : (as per your design requirement)

Go to Tool Menu ...Click Profile Placer
e Select Ring Rail and load in “Curve Shadow Window”
Note: Profile Placer will be shown at the bottom of Ring Rail

e Click on “Profile Placer Window”, it will show built-in library of Profile
Placers.

o Select the shape of Profile Placer as per your design requirement.
Adjust Height & Width of Profile Placer

a- Width = 2.5 mm to 4.0 mm (as per gem size)
b- Height = 2.5 mm to 4.0 mm (as per girdle seat)
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c- Position on Curve= adjust near the prong & lower seat so that it may penetrate inside prong on either side.
e Click “Add Mirror” to get duplicate Profile placer on opposite side.

Note: Click Right button of Mouse at any View Port window to come out of this command.
e Go to Surface Menu .....Click Sweep1 o m— e
It will ask: ’ ‘

a- Select Rail: Click on Ring Rall

e Select Cross Section: Click one by one on
Profile Placers

e click Enter key two times.

Note: Uncheck the “Close Sweep”

e Click “OK” in opened window.

e Go to Solid Menu ..... Click “Cap Planar”

e Select the Shank Surface and then click to fill the
material.

e GotoTool Menu ..... Click “Object Checker”
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ICON HISTORY X

File View Utilities Measure Custom Reset

® Curve » Surface » Solid ®» Transform® SubD ®Art
» Builder » Tools » Gems » Setting ® Cutters ® Rende

SOOPT s T [ 4 m

N=SsTATATI
) NkP2KEH GO

SRS OHI

At the end Select your complete Ring = Shank+ Gem+ Prongs and load in
Object Check window to verify that the ring is solid.
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PRACTICAL: 4 TO DESIGN A BEZEL SETTING RING

LU1L: Setup interface of Jewellery CAD software

e Goto Tools Menu
e Load Ring Rall
Type your finger size..mm D:
e GotoGemMenu...... Click Gem Loader

® Curve » Surface » Solid ®» Transforme SubD ®Art
» Builder » Tools » Gems » Setting ® Cutters ®Rende

S ey e [ 80 ..

EI

“~
-

e Drag gem on the top of Ring rail by pressing Shift+ Mouse.

Note: the distance between Culet & Ring rail = 1mm

LU2: Create 2D Drawings

Command _gvBezel ~
a;w(wm Height=583 TopThick=11 BaseThick=1.1 DomeHeight=0.01 Angle=-10.2 SeatDepth=1 SeatLength=06 SeatAngle=45 Placement=0 Scale=100 BgolFinger=Yes Styles

e (o to Setting Menu ..... Click Bezel e — O — |
Builder o

e Select gem and load in Gem
Shadow window

e —

e 0=
-
‘r}}l =ﬁ‘;‘ B B

-
BEZEL HEIGHT

(5o I
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Looking Down | ¢ |

( Perspective J(TRIOUGRFinger) Side View |
Looking Down [+]
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Adjust the Bezel parameters.

i- Bezel Height : Don’'t Change
J- Top Thickness: 0.8 ~1.5 mm
k- Base Thickness: 0.8 ~1.5 mm
I- Dome Height: as per your design requirement.
Bezel Angle: (as per your design requirement)
v-shape = 10° Straight = 0° A-shape = -10°
m- Seat Depth : (Don’t change)
n- Seat length: (Don’t change)
0- Seat Angle : (Don’t change)
p- Bezel Placement: Change to make prominent the Gem Table.
g- Bezel Scale: (Don’t change)
r- Bezel Chamfer X: (Don’t change)
Bezel Chamfer Z: (Don’t change)
e Go to Tool Menu ...Click Profile
Placer

Both values should be same

wn
1
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e Select Ring Rail and load in “Curve Shadow Window”
e Note : Profile Placer will be shown at the bottom of Ring Rail
e Click on “Profile Placer Window” , it will show built-in library of Profile Placers.
e Select the shape of Profile Placer as per your design requirement.
e Adjust Height & Width of Profile Placer
d- Width = 2.5 mm to 4.0 mm (as per gem size)
e- Height =2.5 mm to 4.0 mm (as per girdle seat)
f- Position on Curve= adjust inside bezel so that it may penetrate inside bezel on either side.
¢ Click “Add Mirror” to get duplicate Profile placer on opposite side.

Note: Click Right button of Mouse at any View Port window to come out of this command.

LU3: Create 3D Drawings

e Go to Surface Menu ..... Click Sweep1
o itwillask:
b- Select Rail : Click on Ring Rail
c- Select Cross Section: Click one by one on
Profile Placers

e Press Enter key two times.
Note: Uncheck the “Close Sweep”

e Click “OK” in opened window.
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File View Utilities Measure Custom
® Curve » Surface » Solid ® Transform e SubD ®Art
» Builder » Tools » Gems » Setting ® Cutters ® Rende

e Go to Solid Menu ..... Click “Cap Planar”

e Select the Shank Surface and then click to fill the material. & D (969 Tew T 1
O = =TrATA )

MNP 2KEH GO

Al B«

= Loon — ‘o
R T 4

e GotoTool Menu ..... Click “Object Checker”

e Select your complete Ring = Shank+ Gem+ Bezels and load in

Object Check window to verify that the ring is solid.
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Looking Down |+

Through Finger }V
A\
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PRACTICAL: 5 TO REPLICATE A HEART SHAPE PENDANT FROM THE IMAGE BY USING TRACING
TECHNIQUE

LULl: Set up of Commands for Basic Jewellery Article

Place nterp
Background ¥ Curve
Tk
Hide
h
Background gag\livground

Edit
Points

Control
Points

Remove
Background

View, Curve, Surface, Solid, Mesh, Dimension, Transform, Tools, Analyze, Render, Rhino4.0, Help,

u Undo View Change
u Redo View Change

Choose document property ( RhinoRender Mesh Units PageUnits Dimensions G
Command:

LU2: Create 2D Drawings B restore viewpors
1.Insert .jpg picture in Looking Down View by clicking View Menu, [ een
Background Bitmap-Place otats

D Zoom 4

a Set C-Plane 4
Set Camera 4

Background Bitma > Place Background
g P I g

Grid Options Refresh Background

@ Capture 4 Remove Background

7N
¥ Show Viewport Ring gitacthackyoung

¥ Show Viewport Axis Hide Background
Matrix Menus 4 ShontHackground
o Move Background
Viewport Properties... =
Lg) Align Background
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2. sing free form pen tool “interpt curve” from Curve Menu ,

start tracing the outline of either side(left or right) of pandent.

3.Refine the outline by activatingcommand “Edit Points,

And or Control points” or press F10 key.
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View, Curve, Surface, Solid, Mesh, Dimension, Transform, Tools, Analyze, Render, Rhinod40, Help,
u Undo View Change

u Redo View Change

E Restore Viewports

m Pan

Rotate

D Zoom 4

Set C-Plane 4

Set Camera »

[
@ Grid Options

(e Capture 4

- Choose background bitmap option ( Align Extract Grayscale=Yes Filter=No Move Plai
-Command:

Looking Down

4. After perfect tracing and refining the picture outline , “Remove” or “Hide”
the picture.

@ Refresh Background
Remove Background

Extract Background

¥ Show Viewport Ring OR

¥ Show Viewport Axis Hide Background

Matrix Menus » Show Background
Move Background
Viewport Properties...
Align Background
g} Creation) » -
I[ﬁll Scale Backaround

INFU & SETTINGS
LAY nd Looking Down

Add Mirror

Edit
Select Rail

v Ass B

5.Click “Tools Menu” and apply profile placer on each line work. e

Profile Placer’s,
Width= 1.0 mm
Height= 1.0 mm

Adjust “Roll on” to change dome of profile placer on the top.

WIDTH
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File, Edit, View, Curve, Surface, Solid, Mesh_, Dimension, Transform
ICON HISTOR
LU3: Create 3D Drawings

almmlmi"m > =
Loft
HAI" HE'IU

sile

- Tools, Analyze, Render, Rhino4.0, Hel

6.Apply “sweep-1” one by one from Surface Menu. Select Rail and
Cross section for each link as asked, then press “Enter” and “OK”

0 Matrix 63 - Untitled 3dm

File, Edit. View. rface.| Soid, Mesh. Dimension. Transfon

FhEhesan ‘ )

[WATH mENU  Cap Planar

. Tools. Analyze. Render, RhinodD. Help.
»

7.Apply “Cap Planner “ in solid Menu to fill the hollow

sweepl-surfaces .

S A [
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8.Use “Mirror” command to get the duplicate solid

surfaces on left side by defining reference centre.

9.Contruct a “Torus /Dough Nut” from “Solid Menu”in

Side View.
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1ATN MENU

le View Utilities Measure Custom Reset
Curve » Surface » Solid ® Transform® Targets ® Art
Builder » Tools ®» Gems » Setting ® Cutters ® Rende
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ohts FEEN [ Eha o
User 01 [_' 1 [ 1 |
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Looking Down

Reference Centre
{
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MAIN MENU |
ile View Utilities Measure Custom Reset
Curve

Builder # Tools ® Gems » Setting ® Cutters ® Rende

DOPT T
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MAIN MENU |" : Command: _selnone

File View Utilities Measure Custom Reset Command:
® Curve » Surface » Solid » Transform® Targets ® Art

» Builder » Tools » Gems » Setting ® Cutters ® Rende Looking Down

10.At the end use “Object Checker” command in Tools menu to verifiy

that whole pandent is solid. Grid Snap [80-Snaps |
INFO & SETTINGS

|
LAYERS [ To

| PROJECTS

urv U »o0lg i 0 argers

» Builder "Toos » Gems » Setting ® Cutters ® Rende
@)=y £y L 2 . -
SO D kRS W

e N kD KSR E,

11.Finally apply “Boolean Union” to unit or solder all links. N T —

| LAYERS
PROJECTS
#J BOOLEAN
W™ BUILDER

Looking Down

OneByOne O
Force Booleanil

Do Boolean

Undo P 4 lean
Reset t

_: @ &%

Union (Join the Objects together)
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Optional
12.Apply gem with bezel at the desired location.
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»Builder » Tools ® Gems » Setting ® Cutters ® Rende

Ry i LA @Y
SN H",'C‘E]Ej,@,g | |

e ) Lk Dl EH &,

| BEZEL BUILDER 1 .
Boolean o

Shyles *
Reset
> =
- Edit
MODE - Bezel

@e e

=
T =

= BEZEL HEIGHT [ 3.33 mm [

Looking Down

Page | 54



LU4: PERFORM BASIC LEVEL RENDERING

RENDERING PHENOMENON.
The effect of light upon a jewellery article to highlight its material color and shading, brilliance,

so that we can get the feel of photo realistic effects

RENDERING STEPS:

| TRRANE FER VRS PN 1

Requweme.ths. ) o N ] _ File View Utilities Measure Custom
e Position your 3D object in tilt position in Perspective PrallEi R Ty

» Builder » Tools ® Gems » Setting ® Cutters ® Rende
4 o iy Vs s o
4 & G0 S W 0 10
Material Editor

¢ Remove any Duplicate gems, curves, surfaces, £ Bleeo m 0 s 0

ARY: Met .,,L*.ﬁ‘

View Port.

e Enlarge your Perspective View Port.

solids
e Your object should be complete solid by checking in
“Object Checker”

Load Master files without Boolean Union.

Command Steps:
e Go to Render Menu.

e Click on “V-Ray Style”
e Click on “ Add ground Plane”

TIP: Zoom in or out smoothly by holding the control button, then click and hold the right mouse key.

YELLOW GOLD
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Click on the Rendering menu and then choose the VRay Styles tool. By doing so, the VRay Render Builder will appear on the right side of

the screen. This menu is arranged with a neatly ordered outline of materials for you to apply to your model.
Ground Plane

Before you begin to apply materials to your piece, it is very important that you first

VRAY RENDER | é]
assign the Ground Plane to Your viewport. This identifies the area your model rests on

— that is, where it sits in space. Click on the Ground Plane button and it will appear in _n%

the viewport.

Click on “Ground Planes” and load respective back ground of our own choice.

Color Dorme - (Fas) ]
a-Tiles H
b-Wood ,
c-Architecture - olor Doma- Ess) l
d-Fabric---------- Linen and -Silk

Material Editor

The next step is to choose the surfaces you want for your ring and render environment.

We will begin first with Metals. Select Metal Material icon to expand different metals. Select the
model in the viewport you want to apply yellow gold material to, it will turn pink when selected. Select
yellow gold material in material editor Hit Green Play button to Apply yellow gold Material to selected

object. -

Select the model in the viewport you want to apply Platinum material to, Select Platinum material in

material editor Hit Green Play button to apply platinum material to selected object
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Setting Environment

. [E—— 5 X
1. Click drop down icon to expand different environment styles ™
2. Select desired environment to apply.
Setting Resolution
o Click drop down icon to expand different resolution options and set desired resolution
¢ Hit Render button to start rendering.
e After completion of rendering ...... save your rendered image as a picture file (.jpg, .bmp, .gif, tiff, png)....preferably as “.jpg” at required

directory with name.

al Editor

B EE

Module 2 CREATE COMPUTER AIDED DRAWING OF BASIC LEVEL JEWELLERY Page | 57



Frequently Asked Questions
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Test Yourself (Multiple Choice Questions)

LU1L: Setup interface of Jewellery CAD software
LU2: Create 2D Drawings

LU3: Create 3D Drawings
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Introduction
The learner guide for Gems and Jewellery sector of “Jewellery CAD/CAM” will provide an

insight to the development of the Gem and Jewellery industry on modern means of
technological advancements. It will provide an opportunity to the learner in better
understanding of the use of Jewellery CAD/CAM software in providing state of the art
solutions to the customers. A special care is observed in designing the learner guide to bring
an easy solution in understanding with examples and practical exercises for your first time
users and also it will bring a lot learning opportunities for the mid-career workers in the
sector. Programme is to engage young people with a programme of development that will
provide them with the knowledge, skills and understanding in working as a well
professionally groomed worker or even starting own venture as an entrepreneur. The
programme has been developed to address specific issues, such as the national, regional
and local cultures, the manpower availability within the country, and meeting and the
exceeding needs and expectations of their customers. The main elements of your Teaching

and Learning Material are:

Introduction:

This includes a brief description of your guide and guidelines for you to use it effectively.
Modules:

The modules form the sections in your Teaching and Learning Material.

Learning Units:

Learning Units are the main sections within each module

Learning outcomes:

Learning outcomes of each learning units are taken from the curriculum document

Learning Elements:

This is the main content of your Teaching and Learning Material with detail of the knowledge
and skills (practical activities, projects, assignments, practices etc.) you will require achieving
learning outcomes stated in the curriculum.

This section will include examples, photographs and illustrations relating to each learning
outcome

Summary of modules:

This contains the summary of the modules that make up your Teaching and Learning
Material

Frequently asked questions:

These have been added to provide further explanation and clarity on some of the difficult

concepts and areas. This further helps you in preparing for your assessment.
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* Multiple choice questions for self-test:
o These are provided as an exercise at the end of your Teaching and Learning Material to help

you in preparing for your assessment.
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MODULE 3: CREATE COMPUTER AIDED DRAWING OF INTERMEDIATE LEVEL JEWELLERY
OBJECTIVE:
The purpose of this module is to enable the trainee in designing computer aided 3D model of jewellery article at intermediate level of difficulty

while using jewellery CAD software and performing rendering

MODULE SUMMARY

This module is an essential milestone in designing and understanding of the fundamentals of jewellery article on computer aided software at
intermediate level of difficulty. It will cover the basic elements and principles of design that how trainee will transfer ideas in to practical
jewellery article on CAD software. Furthermore it emphasizes the designing of jewellery article conceptually following manufacturing techniques
to produce jewellery article with precision and accuracy. It covers the setup interface of Jewellery CAD software, creating 2D and 3D drawings

and to perform intermediate level Rendering.

The course learning units are arranged in such a way to integrate concepts and ideas related to each topic through tools and application-
oriented projects. This makes the learning simple and systematic and enables one to gain more insight knowledge on the various tools

covered.
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LEARNING UNIT 1: SETUP INTERFACE OF JEWELLERY CAD SOFTWARE
LEARNING OUTCOMES
The trainee will be able to:
o Analyze jewellery article on measurements (Rings, Earing, Bangles and Pendants).
e Set up commands in CAD Jewellery software.
For setting up the software interface of the Jewellery CAD software, first of all analyze the jewellery article from all views then we have to note
its critical dimensions/ gauges by using the appropriate tools.
LEARNING UNIT 2: CREATE 2D DRAWING
LEARNING OUTCOMES

The student will be able to:
e Scan and import image of manual 2D drawing if required.

e Create 2D drawing
LEARNING UNIT 3: CREATE 3D DRAWING
LEARNING OUTCOMES

The student will be able to:
o Generate 3D surface using cross sections etc.
¢ Place intermediate level design components (Gemstone, metal inserts etc.) on jewellery article.
e Assign material to 3D model and calculate weight of jewellery article and its components.

o Create specs sheet of designed jewellery article
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LEARNING UNIT 4: PERFORM INTERMEDIATE LEVEL RENDERING
LEARNING OUTCOMES
Trainee will be able to:

e Prepare 3D model for presentation.
e Apply customized parameters.

e Create animation of 3D Jewellery Article for presentation
TOOLS AND MATERIALS REQUIRED FOR LU 1,2 3 AND 4

e Computer System compatible with CAD software

e Operating system (Microsoft Windows)

e Jewellery Design Software (Rhinoceros 3D & Matrix)
o Paper Printer (Colour)

e Steel Rule

e Paper cutter

¢ Ring Sizer

e Vernier Caliper
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ANATOMY OF RING

CENTER STONE

SIDE STONE

HEAD

ACCENT STONES

SHANK
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SHAPES OF SHANK

Pinched

N
C

Y
i

&

Flair

Cathedral

Freeform
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X0

Reverse Tapered

SHAPES OF SHANK
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SHAPES OF PROFILE PLACER

. OUTSIDE PROFILES

Knife-Edge Half-Round Edge

- INSIDE PROFILES

PP

, \
Light Comfart-Fit Comfort-Fit Heavy Comfort-Fit- ‘Scooped
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RING STYLES

Bridal Set
(Engagement Ring and Wedding Band )

Wedding Band

Anniversary Band Eternity Band

Halo 3-Stone
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PRONG TYPES AND STYLES

Six Twao (Vertical)

. [N
&

/

Four (Diagonal) Eight Two (Horizontal)

Basket Peg Head Decorative

Half-Bezel Bar/Channel

Channel Trellis
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DIFFERENCE BETWEEN KARAT AND CARAT

KARAT
e |tis defined as the percentage of purity in gold.

o Jewellery is not manufactured in pure gold because it is easily distortable and deform.

¢ Gold is mixed with different metals to increase its mechanical properties for manufacturing jewellery article
Pure Gold =24 K 1K =11.664 gm

CARAT
e ltis defined as a unit to measure the weight of a gem stone

1 Gm =5 Carat 1 Carat = 100 Cent

CHANNEL SETTING

e The stones are aligned in a channel, sitting girdle-to-girdle.
e Step-cut stones can rest on a track giving a "keystone" effect.

e Matching stones that are cut to a uniform size for use in channel settings are called "calibré-cut,” as in "eternity rings."

nLx
X
X
X
17%/

i
]
I

Cross-Section Overhead

Channel Setting
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PAVE SETTING

e ltis atight grouping of identically sized stones laid across a flat or convex surface, from the French word for "paved.”

e The stones are held in place using three to six raised prong per stone
BAR SETTING

A variation of the channel setting is the bar channel setting.

* The metal plates in the channel rise to the top level of the stone and can be seen between the stones.

Pavé Setting
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PRACTICAL 1: DESIGN A FILIGREE PENDANTBY DEVELOPING BEZEL AND PRONGS MANUALLY
LU1L: Setup interface of Jewellery CAD software

Commands Detalil

Circle, Interp Curve, Offset Curve, Ellipse, Helix, Extrude Surface Straight, Chamfer,

ile View Utilities Measure Custom Reset
Gem Loader, Array Polar, Mirror, Trim, Delete, Join, Fillet, Layer Menu, Solid Box ® Curve » Surface » Solid ® Transform® SubD @®Art
LU2: Create 2D Drawing * Builder » Tools » Gems » Setting » Cutters ® Rende
e Draw a circle of diameter = 20mm using “circle command” in Curve Menu S

e Draw two more circles one is inner of dia 10 mm, (\) M § m% a a m ‘\\ m ¥ o

and other is off center of dia = 3mm

Then using “Array Polar” command from Transform Menu

'MAIN MENU x|
File View Utilities Measure Custom Reset
® Curve » Surface » Solid ® Transform®» SubD ®Art

« Builder » Tools » Gems » Setting » Cutters » Rende

‘$l¢ € ¢ “5a B T -
L o o BE . g oty LS
Eﬂa”:'gf]iqm &< o (Y ]

-
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e Draw a spiral shape using “Interp Curve”

'MAIN MENU X
File View Utilities Measure Custom Reset

® Curve » Surface » Solid » Transform® SubD @®Art
» Builder » Tools ®» Gems » Setting ® Cutters ® Rende

2D®©3Nhgg

ST TR ks
ONMPRRKEELEG O

e Mirror the spiral shape by using Mirror command from “Top11Tools Menu”

2e ) Nk Dk BE GO

!
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e Draw another offset circle of inner circle with offset distance = 0.5 mm

kS|

'MAIN MENU
File View Utilities Measure Custom Reset
® Curve » Surface » Solid ® Transform e SubD ®Art

« Builder » Tools » Gems » Setting » Cutters ® Rende

/> 7 2 [0 N kel m
NOSEaE NN SE

LU3: Create 3D Drawing

Convert inner circular curves in solid surface by applying “Extrude Curves Straight” from Solid Menu.

SiATangents=No_ SetBasePoint ) 15

Y Curve Tools ) Surface Tools ) Sold Tools } Mesh Tools  Render Tools ) Drafing V' New in VS |

|

Extrusion distance <-1.5> ( Direction Both Solid=Yes

ile View Utilities Measure Custom
Curve » Surface » Solid ® Transform® SubD @®Art
" Builder » Tools » Gems » Setting » Cutters ® Rende

D@@tw.fgﬁg
=T 114481

e The extruded height is 3mm,

e This will create the inner bezel
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o Convert outer circle to small bezel of height 1.5 mm following the same above procedure Draw another

vecond. 3 i 300 Extend D

G ) P YRV, Uiy S ) Vawpor Loy Vi owafors ) Ui Yy Sice Y ) St Yoia Vs o ) B Yooh ey ) o %
CAOADPSARN Il aeasd J@FF0L TR IR YPErrow oY,

}

| |
Extrusion distance <-1.5> ( Direction BothSides=No Solid=Yes Deletelnput=No ToBoundary SplitAtTangents=No SetBasePoint ) 15| I

8@xr Baua

e Apply Chamfer command to the edge of both bezels from Surface Menu

'MAIN MENU x|
File View Utilities Measure Custom Reset
® Curve » Surface » Solid ®» Transform» SubD ®Art

» Builder » Tools » Gems » Setting ® Cutters ®Rende

-7 2 — 2 1 ‘ s [
T HFNFY S P b
== AP S

7

Select second surface to chamfer ( Distances=0.300,0.300 Exiend=Yes Trim=Yes ).

Module 3 CREATE COMPUTER AIDED DRAWING OF INTERMEDIATE LEVEL JEWELLERY Page | 16



e Apply Join command if the surfaces are open.

%™y ik > 2K EIE: [ O

Width  Depth Pe

Aﬁ,‘; 6.8 4.23 I L:Zj %

Width Depth
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b

X
N/
X/

C
% y

4

Draw a small circle of dia = 0.5 ~ 1.0 mm between inner and outer gems to make a central prong.

degree.

Move

&l
File View Utilities Measure Custom

Reset
® Curve » Surface » Solid ®» Transform e SubD ®Art

» Builder » Tools » Gems » Setting ® Cutters ®» Rende

L

Extrude the inner prong to height of 2~3 mm by using “Extrude curve Straight command”

Apply “Array polar” command to outer bezel and prong to make a set of “4” by giving center reference to F4 and step angle of 360

Press Enter to accept. FillAngle = 360 ( ftems=4 FillAngle Rotate=Yes ZOfiset=0 )
“Standard ) CPlanes J/SetView | Display ) Select
SR Fei¥ L

Perspective | Throug

Viewport Layout ) Visibility » Transform ) Curve Tools ) Surface Tools ) Solid Tools
R , = ~ /T
0D BB remnd SOIF0D O

) Mesh Tools ¥
ger | Side View | Looking Down | % |

Render Tools » Drafting » Newin V5 |

IR E T e R F

I|Pren Enter to accept. FillAngle = 360 ( ltems=4 EillAngle Rotate=Yes ZOffset=0)
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e Construct micro prongs for outer small
bezel of dia = 0.8 ~ 0.5 mm by following

the same above procedure.

e Round off all edges of prongs to radius of 0.6 mm by applying command “Fillet Edge “ from Solid Menu

| Select fllet handle to edit. Press Enter when done ( AddHandle CopyHandle SetAll LinkHandles=No RailType=RollingBall SelectEdges Preview=No TrimAndJoin=Yes ). 6 |

Reset
® Curve » Surface » Solid ® Transform e SubD ®Art
» Builder » Tools ®» Gems » Setting ® Cutters ® Rende

6){')(5)691':'. Q{_}m
(O =T AR

Metal
Metal
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e Apply array polar command to replicate 4 small bezels

e Use the “Helix” command develops helix around the curve with the parameters as shown below.

» Builder » Tools » Gems » Setting ®» Cutters ® Rende

N NE= O E

“NNQOQ/ANEEN

I ‘Rndiu: and start point <0.150>  Diameter Mode=Tums Tums=15 Pitch=1.47751 ReverseTwist=No NumPointsPerTum=>5 ). | |

e Create another helix in reverse direction by using the above same command
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e Apply “pipe command “from solid menu having dia = 0.45 mm on both helix curves to develop Filigree.

File View Utilities Measure Custom Reset
® Curve »n Surface » Solid » Transform» SubD @®Art

» Builder » Tools » Gems » Setting ® Cutters ®Rende

DOOPT mrwr T L4
(G X =T AT

Pipe diameter <0.450> ( Radius Thick=No Cap=Flat FitRail=No ): I

e Click Purple Layer on for the hidden bezels
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Create the base curve as a foundation around the filigree by using “Curve Off Set” at 0.3 mm.

ile View Utilities Measure Custom Reset
® Curve » Surface » Solid ® Transfgam ® SubD ®Art
» Builder » Tools » Gems » Settindjlj Cutters » Rende

7 2 00O W ke & 18
NS ABMNN T -

|Sidetooﬁ|el(gistance=0.3 Corner=Sharp ThroughPoint Tolerance=0.001 InCPlane=No Cap=None ):

Trim and delete the unnecessary curves by using Trim and Delete commands and then apply “Join” to open curves for

[ ]
making one closed curve.

ce )ik DK

e Extrude the above curves to 1.0 mm by using “Extrude Curves Straight”
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e Create an intermediate block of dimension 0.6 x0.45x1.0 mm by using “Box” in Solid Menu

File View Utilities Measure Custom Reset

® Curve »n Surface » Solid ® Transforme SubD @®Art

» Builder » Tools » Gems » Setting ® Cutters ®Render @
OPT ww T Lk
6) P ® G i) NN

-

Cy o= <rildhl

e Mirror the solid block by using a reference of 45 degree from Grid Tool Bar.

—>

e Create the duplicate copies of block by applying “Array Polar’ command

B o
%-@
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Click the essential layers on from Layer Menu

e Create a “Circle “of dia 2.0 mm at the top of pendant for hanging hook. Apply Pipe of dia=0.5 mm.

| |
I Radius <1.000> { Diameter Orientation Circumference Area ]:I

e This hook can also be created through Solid Torus

e Atthe end draw an Ellipse of dimensions as shown.

e Solidify it by using “Pipe” command again.
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e Finally the pendant will be checked in Object Checker to ensure its Solidification.
e Weight of metal and gems can be calculated using the specific commands.
e Finally Filigree Pendant and then Render it.

| ' > 5 | P -

Looking Down |+

RENDER IMAGES
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CONVERTING CAD FILES TO CAM FILE

Matrix software has a strong algorithm to convert CAD model into machine language to produce physical wax pattern either by CNC machining

or Rapid Prototyping.

BASIC REQUIREMENTS:

Select All Curves
. i Select Open Curves
e Obiject should be a perfect 3D solid model Select Closed Curves

Select Planar Curves
Prompt Select Curves

e Hide all Curves , 2D- surfaces , Duplicate object &

Select All Surfaces
Select Open Surfaces
Prompt Select Surfaces

Gems by using “Super Select” command.

Select All PolySurfaces
Select Open PolySuifaces
Select Closed PolySurfaces
Prompt Select PolySurfaces

STEPS:

Go to “File Menu”

Select your 3D —model (so that it becomes pink).

All Gems
Prompt Select Gems

churramn All Objects

/ Last Object
Previous Objects
By Material

Click “Export selected”

p w DD PR

Target window will be opened to save your model in required directory

And give a unique name to file.

5. Select file type “ . stl”

T

|| j Save I
| Carel |

=X I Stereolithography [~ =] LI Cancel

6. Mark tick on “save small”

7. Then click “Save”

[T Save small [T Save geometry only
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This will open a window showing E BDMezh Export Dptions <]

8. Set Tolerance to 0.01mm.

Tolerance

The masimum diztance between the onginal zurface or zolid and
the polygon mesh created far the STL file.

0.01 millimeters

k. Cancel | F"reviewl Help | Detailed Contrals. .

9. It will convert into STL Mesh format by showing window.

10. Save the file in “ Binary” file type and

Then press “OK”. STL Export Options [ x|

11. It will process your 3D Model into STL CAM file. File type Approximate Size
&% Binamy 1998Kb
i Ascii 11153kKb

[¥ Export open objects

ak. I Cancel Adiuzt Mesh
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Frequently Asked Questions
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Test Yourself (Multiple Choice Questions)
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Introduction
The learner guide for Gems and Jewellery sector in “Jewellery CAD/CAM” will provide an

insight to the development of the Gem and Jewellery industry on modern means of
technological advancements. It will provide an opportunity to the learner in better
understanding of the use of Jewellery CAD/CAM software in providing state of the art
solutions to the customers. A special care is observed in designing the learner guide to bring
an easy solution in understanding with examples and practical exercises for your first time
users and also it will bring a lot learning opportunities for the mid-career workers in the
sector. Programme is to engage young people with a programme of development that will
provide them with the knowledge, skills and understanding in working as a well
professionally groomed worker or even starting own venture as an entrepreneur. The
programme has been developed to address specific issues, such as the national, regional
and local cultures, the manpower availability within the country, and meeting and the
exceeding needs and expectations of their customers. The main elements of your Teaching
and Learning Material are:

Introduction:

This includes a brief description of your guide and guidelines for you to use it effectively.
Modules:

The modules form the sections in your Teaching and Learning Material.

Learning Units:

Learning Units are the main sections within each module

Learning outcomes:

Learning outcomes of each learning units are taken from the curriculum document

Learning Elements:

This is the main content of your Teaching and Learning Material with detail of the knowledge
and skills (practical activities, projects, assignments, practices etc.) you will require achieving
learning outcomes stated in the curriculum.

This section will include examples, photographs and illustrations relating to each learning
outcome

Summary of modules:

This contains the summary of the modules that make up your Teaching and Learning
Material

Frequently asked questions:

These have been added to provide further explanation and clarity on some of the difficult
concepts and areas. This further helps you in preparing for your assessment.

Multiple choice questions for self-test:

Module 4 Create Computer Aided Drawing of Advance Level Jewellery
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o These are provided as an exercise at the end of your Teaching and Learning Material to help

you in preparing for your assessment.
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MODULE 4: CREATE COMPUTER AIDED DRAWING OF ADVANCE LEVEL JEWELLERY
OBJECTIVE:
The purpose of this module is to enable the trainee in designing computer aided 3D model of semi complex jewellery article using CAD

software and performing advance rendering.

MODULE SUMMARY

This module is an essential milestone in designing and understanding of the fundamentals of jewellery article on computer aided software at
advance level of difficulty. It will cover the basic elements and principles of design that how trainee will transfer ideas in to practical jewellery
article on CAD software. Furthermore it emphasizes the designing of jewellery article conceptually following manufacturing techniques to
produce jewellery article with precision and accuracy. It covers the setup interface of Jewellery CAD software, creating 2D and 3D drawings

and to perform advance level Rendering.

The course learning units are arranged in such a way to integrate concepts and ideas related to each topic through tools and application-
oriented projects. This makes the learning simple and systematic and enables one to gain more insight knowledge on the various tools

covered.
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LEARNING UNIT 1: SETUP INTERFACE OF JEWELLERY CAD SOFTWARE
LEARNING OUTCOMES
The trainee will be able to:
o Analyze jewellery article on measurements (Rings, Earing, Bangles, and Pendants etc.)
e Set up canvas in CAD Jewellery software.
For setting up the software interface of the Jewellery CAD software, first of all analyze the jewellery article from all views then we have to note
its critical dimensions/ gauges by using the appropriate tools.
LEARNING UNIT 2: CREATE 2D DRAWING
LEARNING OUTCOMES

The student will be able to:
e Scan and import image of manual 2D drawing if required.

e Create 2D Drawing
LEARNING UNIT 2: CREATE 2D DRAWING
LEARNING OUTCOMES

The student will be able to:
e Generate 3D surfaces using rails, cross sections etc.

¢ Place advance level design components on jewellery article
e Assemble different parts (links, hinges and findings etc.) of jewellery article.
e Assign material to 3D model and calculate weight of jewellery article and its components.

o Create specs sheet of designed jewellery article.
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LEARNING UNIT 4: PERFORM ADVANCE LEVEL RENDERING
LEARNING OUTCOMES
Trainee will be able to:

e Prepare 3D model for presentation.

o Apply customized parameters Create customized background image (s) / logo (s).

e Create customized color of metal according to Cartage.

e Create customized color of gems and pearls.

e Assign color of enameling film (if required).

o Execute advance level rendering of 3D Jewellery Article.

o Create advance level (object and camera) animation of 3D Jewellery Article for presentation
TOOLS AND MATERIALS REQUIRED FOR LU 1, 2 3 AND 4

e Computer System compatible with CAD software

e Operating system (Microsoft Windows)

e Jewellery Design Software (Rhinoceros 3D & Matrix)

T YAl

e Paper Printer (Color)
e Steel Rule

o Paper cutter

¢ Ring Sizer

e Vernier Caliper
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LEARNING UNIT 5: GENERATE CAM FILE
LEARNING OUTCOMES
Trainee will be able to:
o Ensure 3D solid model is water tight and excludes gems, naked edges, duplicate and open surfaces.
o Export CAD file of 3D jewellery model according to CAM file format.
TOOLS AND MATERIALS REQUIRED
e Machine as per software compatible
e Operating system (MS Windows)

e Jewellery Design Software (Rhinoceros 3D & Matrix)
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SOME BASIC CONCEPTS AND UNDERSTANDING
RING SIZE

@@@5@@

Nmrﬂ ! A mm 14..,r-'n )S?n‘m 156mn 16rrm
i 6 @ @ 4
7 <

1645 men !tx?rrm “17men ISArrm “186mm
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2# (9mm Thick)
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INTERNATIONAL
RING SIZE CHART

Measurements Ring Conversion Table
Inches mm US |Japanese|French| Swiss German | British
13/4 445 3 4 44 4 14.0 F
125132 45.2 3.5 6 45 5.5 14.5 G
11316 46.0 4 7 47 7 15.0 H
17/8 47.6 4.5 8 43 9 15.5 1
11516 49.2 5 9 50 10 15.8 J
2 50.8 5.5 10 52 12 16.0 K
2116 52.4 6 12 53 13 16.5 L
23132 53.2 6.5 13 54 14 17.0 M
21/8 54.0 7 14 55 15 17.3 N
2316 55.6 7.5 15 56 16.5 17.8 O
21/4 57.2 8 16 57 18 18.0 P
25132 57.82 8.5 17 58 19 18.5 Q
25186 58.7 9 18 59 20 19.0 R
2 3/8 60.3 9.5 19 €60 21.5 19.5 S
2716 61.9 10 20 61 22 20.3 i
21/2 63.5 10.5 22 62 235 20.8 U
29/16 65.1 11 23 63 25 21.0 W
219/32 65.9 11.5 24 64 26 21.3 X
25/8 66.7 12 25 66 27.5 21.8 Y
Page | 8
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ADVANCE GEM SETTINGS
FRUSTUM SETTING
e A Frustum, or "Hollow Cone" setting is a Y NS

conical or tapered setting constructed from
sheet metal.

e The stone's pavilion rests against the inside

of the cone and the outer edge of the cone's

. _ Cross-Secton Overhead
lip is bet over the girdle to secure the stone.

Frustum Setting

ILLUSION SETTING

¢ Anillusion setting is designed to make a stone look larger than it really is.
e It consists of a white gold or platinum disc with a hole in the center into which a small stone is fitted.

e The stone is traditionally bead-set or grain-set and the chiseled beading creates carved facets on the disc, which enhance the stone
and confuse the eye.
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INVISIBLE SETTING

e The invisible setting technique was developed in
France more than two centuries ago.

e Invisible setting is popular because of its clean
minimal look.

e Grooves in each stone's girdle slip into a metal
framework below the surface, but the metal cannot
be seen, so the stones will sit side-by-side,

creating a solid surface of gems.

e The invisible setting technique is used to create

the illusion of larger diamonds in engagement and wedding rings.
TENSION SETTING

e It uses the metal's natural tendency to

"spring” back to its original position to

hold the stone in place.
e The metal is spread apart, and the
girdle of the stone is seated into small

grooves in the inside surface of the

metal.
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ANATOMY OF GEMS

Diameter
| Table

Star Facet
Bezel Facet Crown
Upper Girdle

Facet N —I—

Lower Girdle [ |
Facet Girdle
Pavilion
Facet
Pavilion

Culet

preSSUre .

burr goes
over the stone
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SUMMARY OF STONE SETTINGS

(REF: STULLER BASIC JEWELRY MANUAL)

Basket Peg Head Decerative

Bead and Bright-Cut/Pinpaint

Bezel Gypsy/Flush Swface Prong
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CABOCHON
¢ The shape cabochon (KAB-oh-shon) refers to a piece of gemstone (or other material) which has been shaped and polished, instead

of faceted.

e Such stones have a domed front surface and a flat back

(Ref :https://www.firemountaingems.com/resources/jewelry-making-articles/c77] )

@
2
&

Module 4 Create Computer Aided Drawing of Advance Level Jewellery Page | 13


https://www.firemountaingems.com/resources/jewelry-making-articles/c77j

BOOLEAN OPERATIONS: Boolean Operations are used

= To join or weld or solder two or more solids that are in contact
= To subtract or drill holes or to make cavity in solids

= To intersect or extract the common part between the solids

Note: These operations are only applicable to 3D solids not on curves and 2D surfaces.

OneByOne ¢
Types of Boolean Operations:
Do Boolean

Undo Boolean

Reset

1. Boolean Union

Combines/ weld / solder two or more solids that are in contact

. tter | Keep Cutter C
2. Boolean Difference | DreByOre 0

Force Booleanil

Do Boolean

Subtracts or drill holes or make cavity in solids L

3. Boolean Intersection

Extracts the common part between two solids

Force Boolean©

Do Boolean
Undo Boolean
Reset

o &

Intersection (Keep Overlapping Parts)
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Perspective

PRACTICAL: 1 DESIGN A FLOWER BY CREATING A SYMMETRICAL DOME SURFACE
LUL: SETUP INTERFACE OF JEWELRY CAD SOFTWARE

e Construct a symmetrical line work in Looking Down window using freeform command

“Interpt Curve” and declare it as Rail-1

Curve, Surface. Soid, Mesh, Dimension, Transform. Tools, Analyze. Render. Rhino4.0 . He\p,‘

. Point Object b | Fle Edit view Cuve Suface Soid Mesh Dimension Tramsform Tools Analyze Rer
Command: _gvCommand
» _
i E Point Cloud Command: _InterpCrv

Start of curve ( Degree=3 Knots=Chord StartTangent )|

' Line 4
| Polyline »
3
3

7} T-Spinestoolbars 7} Toolbars wih te
5

Looking Down

| e
[ roren
'

N
|

i Ellipse 3 Sketch
>
v v
l. Hyperbola » E Sketch on Surface
[, - | i) [

e Make a similar copy of above interpt curve either by using command “Mirror” or
“Duplicate and declare it as Rail-2

Note: Don'’t try to join the end points of above two curves.
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| |Lrection at starn:
Reset Command:

MATN MENLF Arc Direction
ile View Utilities Measure Custom

LU2: CREATE 2D DRAWING
Go to Through Finger Window, and draw a dome arc by using command “Arc

[ ]
Direction”, so that it may touch the mid points of both interpt curves.
e The required arc will at 90° to both interpt curves.
i IT o
OLF [
[ [ o
° CIICk Surface Menu and apply Command SWeep‘2 by SeIeCtIng Surface ., Solid . Mesh | Dimension . Transform . Tools , Analyze , Render . Rhino4.0 . Help
b fiew Curve Surface Soid Mesh Dimension Transform  Tools  Analyze  Renc

rc ( Direction Radius ). _Direction
t start:
d:

1stinterpt curve as as Rail-1 and then select 2" interpt curve as Rail-2

H %) TSpines toobars ) Toolbars wit e
)

! Sweep 1 History

2]
ity Sweep 2 History.

| Sweep Multi
@ Profile Sweep
.
@ Rail Revolve

! I@ Curve Network

Bad Comer Points

Looking Down

ﬁ Point Grid
i m Extrude Curve D

| Patch
[
Heightfield from Image
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e Then select Arc Direction as a “cross section”.

e This will show a Sweep-2 window.

e Atthe end click “OK” to get hair line 2D Dome surface.

o Repeat the same command “Sweep-2” to complete the remaining dome surface.

LU2: CREATE 3D DRAWINGS
e To convert 2D Dome surface to 3D surface, go to Solid Menu.

e Click “Extrude surface straight” and type required thickness e.g 1.0, 1.5, 2.0, 2.5 etc...

Place a dome surface petal at a distant of 4~5 mm apart from grid origin.

Looking Down

Module 4 Create Computer Aided Drawing of Advance Level Jewellery
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m Sphere
Cylinder
Truncated Cone
n Pyramid

Solid, Mesh, Dimension, Transform, Tools, Analyze, Render, Rhino4.0, Help,

ace  Solid Mesh Dimension  Transform  Tools  Analy

-

es. Press Enter when done { Point )
Esc to cancel

-

J ;j' T-Splines toolbars ;j' Toolba
-

: Ellipsoid
: Paraboloid
m Tube

Pipe

Slab
E Torus

-

Extrude Planar Curve

.| Transform, Tools, Analyze ., Render , Rhino4.0 . Help .,

==

Mave

't Copy

]

./
g
&
&

-_—
g
&
7
&

Hesh  Dimension  Transform  Tools  Analy

000> { Copy ):

= Orient

Array

! Set Points
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Looking Down

e Go to Transform Menu and Click Array and then “Array Polar”

e This command will be executed as follows:

e Select object to array: click the 3D dome motive & Press “Enter”.

o Center of Polar Array: Press “F4”

¢ Number of items: type 5,6,7..(no. of copies to be filled within 360 deg
e Angle to fill or first reference point: type 360

e Then press “Enter”

e This will show a repetitive pattern of dome motive in a circular form.
e To make this dome motive more beautiful , put gems on each petal using
command “ Gem on Surface” and place prongs by using command “Prong on

Surface” one by one.
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PRACTICAL 2: DESIGN AN OVAL CABOCHON RING

Create Oval profiles and sweep function.

Learn to use the CurveNetwork and MatrixArt tools to draw an engraved oval

and Project Curves,

ring. Practice 2D drawing with interpCrv, blendCrv, JoinHistory, Create UV Curves,

Ring Rail W% Profile Placer &l Sweep 1 History Cap Planar

LUL: Setup interface of Jewelry CAD software
To start this practical make sure that

1. all snaps are switched off except end O-Snap and mid O-Snap in Snaps menu

2. all display modes are swithed off in display menu

3. All three History buttons v i are active in Info And Settings menu.

LU2 and LUS3: Create 2D Drawings and Generate 3D Surfaces
1. Begin with Ring Rail
Click on the Tools fly-out menu and select the Ring Rail tool. Select a Size 7 ring rail from the drop down

menu and click on the green arrow D button to place it in the viewports
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2. Add Oval Cabochon File View Utilities Measure
' ® Curve » Surfacen SclideT
1. Open Gem Loader in Main Menu, » Builder » Tools ® Gems 0 S

o r'ﬂc’?a(%ﬁ%‘:
LRl oA

2. Choose Gem cut type, Cabochon shape in this case the from the fly out button at the right of cut type

€ CuT TYPE [N

|Gem Shape)|
3. Choose required size or in this case put the values 9.9 in Length, 8.0 in width, and 3.15 in depth

column and hit the green play button at the bottom right.ﬁ Oval Cabochon will appear in the center
of the viewport.

3. Place the Cabochon at required position

Select Cabochon and run move command in “Top 11 tools bar”
2. Snap the top endpoint of the cabochon to define ‘point to move from’,
Left click on it to drag the Cabochon,

LSNP RKEH RO
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3. Switch the quad Snap On while the move command is active and place the cabochon to

the top quad position of the ring rail {SNAPS - 1%
! ‘ atc ributes
EREF LR HE N i o
y Gy
Head Builder
Halo Builder
® TSplines Bezel
| | ® TSplines Under. Bezel
& Gem Cutter
® Azure Cutter

4. Switch On the Gumball from the ‘info and |INFO & SETTINGS
settings’ toolbar while the cabochon is still | PRSE- o E" '
selected, Translation handles of Gumball will ' o= G 7:;{ o=

appear on the cabochon

5. Click the Yellow (Z axis) handle once, a small dialogue will open, put the required
value in the dialogue, 6.5 in this case to move the cabochon up, Hit enter and the

cabochon will move 6.5mm up from the top quad of the ring rail.
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4. Setting Bezel to the Cabochon

e Select Cabochon, hit F6 key or press mouse wheel to open F6 menu

¢ Choose Bezel option in The F6 menu to open bezel builder in the Main menu

¢ Make sure that cabochon is visible in gem/curve window and bezel mode-1 is selected

e Select each of the 12 options and insert values in the bottom right dialogue according to the following chart, left click in the

blank area of the viewport and press enter.

bezel height=2.0mm

top thickness=0.70mm

base thickness=1.30mm 5] BEZEL BUILDER |

dome height=0.10mm GamiCurva | [Edge Brafile] Boolean

bezel angle=0 degree
seat depth=2.10mm
seat length=0.60mm
seat angle=90 degree

. bezel placement=0.0mm
10. bezel scale=100%

11. bezel chamfer X=0.3mm
12. bezel chamfer Z=0.6mm

©oNoGswWDNE
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File View Utilities Measure Custom Reset
® Curve » Surface » Solid ® Transform® TSpline @ Art

5. Creating Curves for ‘Curve Network’ » Builder » Tools » Gems » Setting ® Cutters ®# Rende

‘Ir""]:?m_{@@g ;
\NQ AN ENN

1. Left Click on the green User 02 layer name in layers menu to make it active,

2. Go to curve menu, switch On to second scroll button m and run dupEdge command
Second last at the bottom

3. Select the bottom edge of the bezel to get the edge curve on user 2 green layer

modeling aids.

Make sure that gumball
is active and set to
world mode

Select the right point at 3 o-clock in through finger viewport
Click the red handle once to open dialogue and put the value
1.6mm to move right side and hit enter

Select the bottom point at 6 o-clock and Click once to the
yellow handle to open an input dialogue, Put the value -1.2

in the dialogue to move down the point vertically, and hit enter.
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6. Select right point, Right click the mirror button
IE to select f4 as mirror plane, hold shift key .

make Ortho active and left click upside or downside to

complete the mirror command

7. Switch on the point OSnapE

Run arc

necion | e o oo o

command in
curve menu; snap the right point as start point, choose ‘through Point’ option in command bar and snap the point at 6 o-clock, now
shap the left point to complete the arc direction command

Start Line tooI in curve menu ,

9. snap to the right quad point of oval extracted Curve and
place at top left position to create a reference line for
modeling aid

10. select the line and put in the red Iayerm,

11. Switch on the control point of the selected red line
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12. Run blend tool in curve menu
13. Select the bottom of line as first curve And the right corner of the arc as the second curve to get the blended

curve .

14. Pick and adjust the top point of the red line to adjust the blended curve

15. Select the blended curve and mirror to the left side using the f4 as mirror
plane
16. Select all three curves (arc, blended curve and the mirrored curve and hit

- X Quad
. . GO \ 0.950
Jom! button to make one curve. \ o w Y

17. Select the joined curve, right click on the SplirEH button to split with a point

18. Snap to the point at 6 o-clock and hit enter or right click in the blank area of the viewport
to complete the command.
19. Select all three helping points and red line and hit delete button on keyboard to get rid of

this crap now.

Mid, Point, Quad

20. Select right split curve and switch to the top(looking down) view port, and right click the rotate button to rotate with copy yes
option, press f4 to define rotation center, hold shift key, left click on the right side to define first reference point and draw a 90

degree arc and left click to define second reference point, it will place the same new curve in side viewport,

21. select the curve and switch on the control points, select top three control points, run moveﬂ command, pick the top point to

define point to move from, Snap the right quad of the oval curve and left click to place The control points
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Hit escape key of the keyboard to switch off the
control points, Select the adjusted curve in side
view, and mirror to the left side. Switch off the
gem 02 layer to hide the cabochon, Now we
have four open curves touching each other at a
point in the bottom and a closed oval curve at
the top.

Using these four open curves and a closed curve we are ready to

Edge curves:

Interior curves:

Edge matching

Loose
Position

run the curve network command.

[ oK ]iCancel ‘Il' Help.

File View utilities Measure Custom Reset
® Curve » Surface » Solid ® Transform® TSpline ® Art

» Builder » Too|= #» Gems » Setting ® Cutters # Rende!

J“Xnﬁa 89“

6. Generating Surface Using Curve Network

1. Select all 5 curves and run the Curve Nekwork Command
by going first in Surface Menu, and choosing the Curve
Network from the Surface Menu
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2. A dialogue will open Put the value “0.01” in Edge curves dialogue and “0.1” in the
Interior Curves option, Check mark to preview the surface and if you are satisfied with
the result, then hit Enter to complete the command.

-11.039
¢-11.039,0.000

7. Adjusting the shape of the ring in side Viewport

1. Switch to the Side Viewport L and double

click on it to expand.
2. Select XRay mode in Display menu

3. Left Click on the finger layer color swatch to make it active layer, and right click to select
the Ring Rail on it.

4. Run the ‘Surface Extrude all’ command from the second row of Surface menu

5. Choose Straight option in the command bar while extrude

command active and complete extrude, in side viewport.
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6. Select User01 red layer 150 10 make it active.

7. Select line tooI in curve menu and Draw a reference line at top right side and a reference line

at the bottom right side in side viewport. Select User 02(Green) Laye

make it active

Run Blend command in curve menu,

You will see in command bar (Select first curve to blend —select near end) option, pick the
near end of first line where you want to start blend, You will now see the option in Command bar
(Select second curve to blend — select near end) now pick the near end of the second line

where you want to complete the blend. And you will get a blend curve on User 02 layer

10. If you want to adjust the blend result using rhino history left click on the control points R
Button to switch On the control points for both reference lines on User 01 layer and move

control points to adjust the result curve on user 02 layer.
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11. Now mirror the newly created curve by selecting the ‘start of
mirror plane’ F4 and ‘End of mirror plane’ at the bottom holding

shift key, Left click on the User 03 (blue) Layer name

41 to make it active layer,

12. Run Project command from the second row of curve menu,
and read the command bar carefully, select both newly created
curves on user 02 layers to project and press enter, Now select
the surface created by curve network to project the curves onto,

and press enter to complete the command. You will get two curves

to define the width of the ring.

13. Select the curve network surface and switch On its control points by pressing

the Control Points command in top 11 tools,
14. Region select the control points you want to adjust and 1D scale the control
points using the gumball handle until you manage to get the required shape.

15. Hit Escape key to exit the control points command and you will get this result
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8. Creating Side Cutters for the Shank

1. Switch off the User01, User03, and the finger layer

2. and left click at the User02 layer name to make it activels
3. Draw a curve using interp curve snaping the one end of blended curve as Start and

The other end to complete the curve

4. Left click on “Cutting layer name to make it active

e
5. Run Join History” command Select both curves and hit enter to get a new joined curve on Cutting
(orrange) Layer.

6. Select the orange curve and Run ExtrudeCrv Command in Solid menu,Put extrusion distancelb5,

make sure that the Bothside=yes Bo ®l is set in command bar and hit enter, Select the extruded
poly surface and right click on the mirror button to set the F4 as mirror plane and left click upside holding

shift key to complete the mirror command, You will get two poly surfaces on (orange) Cutting layer.
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9. Creating Inside Cutter for the Shank

1. In Surface menu select second scroll button!%" And Run Off set Srf command
2. Select the light green Surface on Metal03 layer to offset while Cutting layer is

selected and hit enter, Now read the command bar carefully and

a. Set the distance to 1.2, and make sure the solid is set to NO,
b. Left click on the FlipAll to invert the offset direction to inside and hit enter. You will get an offset

surface on cutting layer. Switch Off=EEid IS

visible. 1 1 3
Now e need to extend the top sdge of s ITES I A

surface to make sure that it is higher than the original surface to get an intersection.

the Metal03 layer to make the offset surface

3. Run the extend surface command in the second scroll window of the Surface menu,
Pick the top edge of the offset surface to extend and set the Extrusion
factor value to 2’ and hit enter. You will get the top edge of the
surface extended 2mm.

4. Switch back OnEEEEEITEEE < the Metal03 layer to get the preview of

surfaces on both layers.

5. Run Line® tool in curve menu, Left click on the left side to define ‘start of
line’ and left click on the right side holding Shift key to define the ‘end of line’
and Complete the line as a cutter that fully intersects the top edge of the

orange offset surface,
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6. Run the trim L.% command and select the line as a cutter and left click
on the top edge of the offset surface to trim out and make the edge

planar,

7. Select the extended orange surface and run Cage Edit ﬂ command
In Transform menu, Read the command bar options carefully and

a. Select ‘bounding box’ as control object and hit enter

b. Make sure that coordinate system is set to ‘world’ and hit enter
c. Make sure the cage points are set 4x4x4 for xyz and degree is also set to 3 for xyz (W/ Through Finger | Looking Down | 4

then hit enter,

d. Make sure the ‘region to edit’ is set to ‘global’ and hit enter to complete the command. A cage will appear to edit the trimmed
offset surface.
8. Select the lowest edit points drawing a full window, and move up about 1mm using
Gumball. Hit escape to exit the edit points, select the cage and hit ‘delete’ to get rid of

the cage

9. Switch to the perspective viewport and keep it expanded

to get a good preview of both surfaces,

10. Select both ‘the Curve Network surface’ on Metal03 layer

and ‘offset surface’ on cutting layer,
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+
11. Run Cap Planar . command in Solid menu to cap both surfaces and make them Closed poly
surfaces. Now we have three poly surfaces on Cutting Layer as cutters, and one poly surface on
Metal03 layer and we are all set to do Boolean operation

10. Boolean Operation to the shank

1. Run Boolean Difference command from the
Solid menu,
a. Select the poly surface on Metal03 layer to
subtract from and hit enter,
b. Select three Ploy surfaces on Cutting Layer to
subtract with, keep the Option ‘delete input=yes’

MBSSSNSEENEEN | command bar and hit Enter to complete the Boolean operation.

2. Switch On the finger layer s 1< Select the cylinder on it and hit ‘delete’ to get rid of it.

3. Switch to the through finger viewport and expand it LI=saifinger iv

Switch off the display menu to get wireframe mode

4. Select the ring-rail on finger layer and hit F6,
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omst | %
M»M(Mmm Tolerance=0.001 BothSides [nCPiant

( Perspective JiSideNiewl) Through Finger | "Looking Down | % |

|

5. In F6 menu
a. select the option ‘cut to rail’
b. Select the green object on metal03 from the inside of the rail to cut and

hit enter to get the final plane shank.

6. Switch on the display mode and set to shade mode for all viewports to get
the preview of the shank

7. Right click on the cuttingle——__
User01 EEASHOIN <~ and User03 EEEEIDM < co|or swatches to select the curves on these

layers, and 8/
Outside Ring Rail
Hit delete key to delete these curves. ot Bamasn 2 Ral
/ OCuttoRall
Eternity Ring
_ i Sk
11. Preparing curves and surfaces for FlowAlongSurface g o

Sweep Multi Rail

(Perspective)"ﬁdeviévl:r Through Finger}/Looking Down} \ 1 Closed Planar Curves
1. Switch to the side viewport and expand it ===

Switch On the User02 layer to preview the curves on it

3. Left click on the Cutting =i IEIAEE] [ayer name to make it active

4. Select the blend curve on user02 layer and run Offse command in curve menu, set the
distance value to 0.6, hit enter and left click in the required direction to complete the
command. You will get an offset curve on cutting layer. Make sure that this curve fully

intersects the shank.
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5. Select the new offset curve and right click on mirrorlu command to set F4 as

mirror plane and left click on upside holding shift key to complete the command.

6. Run Line command in curve menu, choose both Sides|S@fteine (st
Option and hit F4 to set the middle of line, Hold shift key and left click about
8mm right side from the center to complete the line command, you’ll get a 16mm

line on cutting layer

7. Use the line as a cutter and trim both curves from the bottom

8. Run Adjustable blend in curve menu and select both lower ends
of trimmed curves to blend, a dialogue with adjustable handles will
appear, hold shift key and pick one side handle to adjust symmetrical
with opposite handle, press OK button in the dialogue when required
shape is achieved to complete the blend command. Select these

three curves and hit join button to make those a single curve.

9. Select thel6mm line which is used as a cutter, Move it up using gumball and
place about 0.6mm below the top of the shank. Now we have a line and a

curve on cutting layer Visible in side viewport.
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10. Left click on User02 Layer name to make it active

11. Run Extract Srf command in solid menu,
a. Select copy=yes option in command bar and
b. Select outer surface of the shank to extract and press enter.

You will get a duplicate outer surface of the shank selected

c. Put the duplicate surface on user04 layer by pressing

input icon EENESINTof the layer and switch off the

12. Run Project command in curve menu, and
a. Select both orange curves in cutting layer to project and press enter

b. Select the grey surface on user04 layer to project to and press enter

You will get projected curves on (bright green) user02 layer
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13. Left click to the User01 ks Layer name to make it active

14. Switch to the Looking Downl L““"‘"@B“‘"“H Viewport and expand it

15. Run Create UVCrvE command and read command bar carefully

a. Select extracted surface on userOIayer to create UV curves

b. Right click on User02=
surface to create UV curves and press enter

layer to select projected curves on

You will get planar UV curves for the surface and projected curve

Planes

:::::l;rm g;
16. Right click on user01 layer color swatch [ ' to select curves and run ® Pt o

Center ObJec command in Utility menu; a dialogue will open with move 7o o 2 ® i

%R &R 0w F.EEE"J
FHL I el 84" IRl ool LS

Center [B

to 0 and xyz checked, click on the green E button to center the curves to
0.

17. While the curves yet selected left click the blue Y axis handleb! of
gumball once to open a small input dialogue and type 30 in the dialogue and

hit enter. The curves will move up 30mm in y direction

Module 4 Create Computer Aided Drawing of Advance Level Jewellery Page | 37



18. While the curves yet selected now left click the Yellow

rotation handles . of gumball once to open input
dialogue and type 180 in the Dialogue and hit enter to
rotate curves 180 degree. Hit escape to clear the selection.

19. Left click on User04 layer name to make it active

20. Select the outer rectangular curve and press & Planar curves button in Surface
menu you will get a planar surface on User04 layer, our curves and Surfaces are

ready to run Flow along Surface command, Now it’s time to create objects to flow

21. Left click on User03 layer name to make it active-£=——"1Ii3

22. Select two curves marked and put these curves To User03 E layer, and
switch Off IR the User01 /G, Usero2 I and user 04 BIE jayers to

view the curves you need to work on.
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23. Select the straight blue line and run Divide Command in second scroll
window of curve Menu, In command bar type 4 to set ‘number of segments’

and press enter.

® Curve » Surface » Solid ® Transform® TSpline @ A
» Builder » Tools # Gems » Setting ® Cutters # Rendd

Once the cursor is locked to elevator mode you N NE =N O 8 © 2
can only move the cursor to the locked direction S NNOAANEENH
>3

In Snap Menu switch on the point and intersect OSnaps

24. Run Line command and snap the second left point as start of line and

Move cursor down while holding shift key and press TAB key to lock cursor

in elevator mode Snap to the intersection point of the second curve as an

Select Points (s 2

Prompt Select Points

end of line and left click to complete the line. [SNAPS] i =
25. Repeat the line command for the fourth point. E~EHEC R BE il

File View Utilities Measure
® Curve » Surface » Solid ® T
» Builder » Tools ® Gems » S¢

Select All Curves
Select Open Curves
26. In Info and Settings Menu press Super Selec button, a dialogue will appear, choose e

Select Planar Curves

Prompt Select Curves

‘select points’ from the list to select all points and hit delete key to get rid of those points.

= r__ - All Objects
User 03 [y : k Last Object

27. Right click on the blue color swatch of User03 layer to select curves on

Previous Objects

By Material

[ra Py Py | (ropge— : Show Hidden Objects
2] L TS|
Pick Hidden Objects to Show

hit enter and while curves selected hit join to get a closed Blue curve. N s SETTINGS "

this layer and left click on trim button in main menu, click on unwanted curves to trim,

Swap to Hidden Objects
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28. Left click on User01hc layer name to switch it On and make active,

And draw a scroll pattern according to your wish using interp &4 Curve
command in curve menu,

Take some time to draw the Pattern and make sure that it is closed and planar
(Only closed and planar curves drawn in any of first 16 layers in looking down

viewport will be accepted in Matrix Art builder)

29. Switch Offm the UserQ1 Layer

30. Switch to LPEEREcHvE [

V|ewport and expand it, select Plastic Mode in Display menu

31. Right click on the Cutting Cutting layer name (to make it active and select curves on it) and hit delete to get rid of

these curves.

32. Select the blue closed curve in viewport and Run ExtrudeCrv command in Solid menu, in command Bar type 0.7 to set

is set

extrusion distance, Make sure that Bothsides=yes BothSides=Yes

in command bar and press enter to complete extrude command.
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12. FlowAlongSurface Operation
1. Switch On[E the User0
surfaces on it Make sure all history buttons in Info and settings

4l layer to show the

are switched On

2. Run Flow Along Srf command in second scroll window of

transform Menu and read the command bar carefully and

® Curve » Surface ¢ Solid:-Transforrr.nTSpline ®Art
» Builder » Tools ® Gems #» Setting # Cutters ® Rende
llayerto iRl At LS
N by LG,
enNr AW &L

a. Select the orange poly surface on Cuttingli#is

flow along a surface and press enter

b. Left click on the near right corner of the planar surface on user04 layer to select as base surface
c. Now left click [ESEEFEESEENEEEEEE  on the near matching corner of the shank to select as
target surface to complete the command. Make sure that Copy=yes and Rigid=no in command
bar. You will get a poly surface on the left side of the Shank to be used as a cutter.
13. Creating inset in the shank for Artwork
1. Switch Offl® the User04EE |ayer

2. Run Extract Srf in Solid Menu Make sure ‘copy=no’ in
command bar Select both end caps of the cutters To extract
and press enter

3. Now hit delete key to delete these caps
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4. Select the open poly surface and Run mirrom command, in Command

bar choose YAxis to complete the mirror along y axis

5. Select both polysurfaces and press joinE button to get a closed
polysurface as a cultter.
= R

6. Switch on the Metal0 EEEEEI 8“7 Jayer to show the shank.

7. Run Difference command in Solid Menu
a. Select the Shank on Metal03 to subtract from and press enter.
b. Select Orange cutter to subtract with
c. Make sure that the Delete Input=yes is set in command bar and press enter to complete the command.
8. Right click on the Cutting layer colorEH swatch to select the remaining object on it and hit delete to get rid of this object.
14. Creatiing Mesh in Art Menu

1. Left click on the Metal01EE=ZE
2. Left click on the Art button in Main Menu, Matrix Art Builder will open at the right

Jl Layer name to make it active

side of the viewport

® Curve » Surface » Solid ® Transforme TSpline ® Art

3. Switch OnE the Usero1 M Layer to show curves on it

4. Select the blue curve on user03EN layer and Red Scroll curve on usero1 [N

layer and put in the input window of the Art menu
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5. Inthe layer graph left click on the red color swatch to make the red layer active and

put the value 0.8 in left dialogue, now left click on the Blue Iayerﬂcolor swatch and put
the value 0.1 in left dialogue.

6. Right click and hold on any blank area of the Builder and drag up to access the lower
menu of the builder

7. Click the play button to
Load Profile [B

open profiles browser and choose ‘flat ‘\ B (e
profile from the browser to set on blue

layer.

8. Letft click the red layer color to make active again and repeat the
Process and choose ‘edge1’ profile for this layer and adjust the Profile in
preview window if you like to. (You may see the dynamic result of mesh

preview in the viewport)

You will get the mesh preview of both layers in viewport
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9. Now notice in the Layer’s graph
a. thereis ared box that sets the relation of the red layer with the
blue layer
b. The red box has a white outline which represents the ‘build
mode’ relation between two layers
10. Left click this red box to turn its relation to blue ‘cut mode’, Left click
again to set the outline to green ‘grid mode’,

Grid Mode means that the red layer has no impact of blue layer on

itself, and it builds from grid if no layer is added below the blue layer.
Layer mode is all set for both layers; we may switch to picture mode

now.
e |[&][E][€]

Update Resolution |T

11. In Matrix Art now switch to the Picture mode ==

. ,’:‘I
12. Go to the current layer option and choose blue 6 Iayer!!l from the You will get this preview

Create Mesh [B¥ | after adding Knurll map
DropDepth Capped u on |ayer6

13. Left click to the blank window to open a browser and N b |

Remove Bitmap ' »

14. Browse the given path to select a bump Map

Current Laye| v

C:\Users\Public\Documents\Matrix8Common\VRay\Library\Bump Maps

And choose the Knurll ma
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15. Look at the Picture mode carefully and complete the following process
1. Set the Resolution to 30 and

. Convert to B Create Mes|
Press playﬁ button to update Resolution ¢ Capp, (1]

Set the bitmap Height to 0.3mm

Load Bitmap [PJ]

Set the Size of width and Height to 20mm Remove Bitmap ¥

. Switch On[=24 the ‘Tile Bitmap’ and ‘Maintain Aspect’ options. [ current Lave[c J&

o o A w N

. When you are satisfied with all settings Press the Play buttonﬁ to Create
Mesh, You will Get a Mesh created
on Metal01 layer

7. Close the Matrix Art builder from top

right corner button 2

[¥] Smooth X
Z Smooth Y
press OK button to reduce crispness of the mesh and repeat Smooth command two three times if |¥/| Smooth Z
(V] Fix Boundaries

16. Select the Mesh on User01 Layer and type “smooth” command in command bar A dialogue will open,

require
@ Word coordinates
(") CPlane coordinates

Smocth factor: 0.5

| ok || Cancel |
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15. FlowAlongSurface Operation to flow Mesh
1. Switch OnEd the User04EEEEENI
the surfaces on it and switch Of the

MetalOBM Layer to hide the shank

2. Run FIowAIongSrf command in second scroll window of

| layer to show

transform Menu and read the command bar carefully and

a. Select the green mesh on MetalOlm layer to flow
along a surface and press enter

b. Left click on the near right corner of the planar surface on user04 layer to select as base surface

c. Now left click on the near matchinﬁ corner of the shank to select as target surface to complete the command. Make sure
that Copy=yes and Rigia=no in command bar

3. Switch On [Edthe MetalOS@ Layer again To show the shank, and switch Off® the User04 Layerm to hide the

Base and target surfaces

i
4. Select the Mesh on Shank and Run Rotate command, choose copy=yes ESEEE
command bar and hit F4 to select 0 as center of rotation, Type 180 in command bar and hit

enter to set rotation angle and hit enter again to complete the rotation with copy process.
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5. elect the Mesh on Base surface and left click once on the yellow Z
handle of gumball to open input dialogue and type -0.8 value and hit

enter to move the mesh 0.8mm down

Both meshes on the shank will be adjusted
following the Rhino History

6. Switch to the Looking Down [eskingBewn ¥ \/iewport and expand it.
7. Select the Mesh and scale Up 1D using x axis scale Handle and see

the result to the meshes on the shank

Module 4 Create Computer Aided Drawing of Advance Level Jewellery
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-14.008,35.677,-0400

Notice the minor gap
where both meshes
meet, we need to fix it

Rotate with copy result

Adjustment result on the
shank
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10.

11.

12.

13.

14.

15.

16.
17.

View Utilities Measure Custom
® Curve » Surface » Solid » Transfor

Switch Offl® the UserO1 Ml and UserO3 3 Layers # Builder » Tools ®# Gems » Setting ® C
. ) L v X . :
EWER]User02 Layer and . P e s BB

Select the Mesh on base surface and put it in EEaaia}
switch off the layer

Switch On the Heads BN, nd Gem02 (IS |ayers

to show the Cabochon and bezel

Left click the View tab in Main Menu and press Restore Viewport
button; you will switch to 4 viewport mode.

Left click the Measure Tab in Main Menu and use Horizontal,
Vertical and diameter tools to draw Technical details on Lights layer

Right click on Metal01,Metal03 and Heads Layers color swatches to

—-'“.
select the ring and press Metal Weights button in Tools Menu, A dialogue will open at the bottom
of main menu, press the green playﬁ button to calculate the weight.

Select all objects in ‘looking down’ and press Zoom Selected button in view Menu or press F3 key

to maximum zoom the objects

Repeat the process for all viewports and right click on Plastic mode button in display menu to

apply this mode on all viewports S Tenme e

» Gems » Setting » Cutters o R

In Main Menu click ‘File’ and “Save Small As”button and give it a name production version, el DI AE u}\ ;fg
Repeat the same save command to save the file as presentation version to prepare it for

presentation
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Perspective |v

Library: METAL

Metal Grams DWT

Yellow Gold:9KY .
Yellow Gold:10KY . =

Yellow Gold:14KY

Yellow Gold:18KY

Yellow Gold:18KY Royal

Yellow Gold:22KY

White Gold:9K PdW |6.04 [389 ||
White Gold:10KX1 537 [3.45 ||
White Gold:10KW 527 [339  []
White Gold:14KX1 6.0 [389 ||
White Gold:14K PdW

Highlight the item you want to find the weight = -
for then press Calculate. ) Side View |v
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PRACTICAL 3: DESIGN A BANGLE
LULl: SET UP OF COMMANDS FOR ADVANCE JEWELRY ARTICLE

e Import picture by using command “Back Ground Bitmap” located in View Menu”

e Draw a ring rail or circle of

diameter 60mm by taking
reference center F4

e From Looking down View, Use “offset curve’
command for offsetting Ring Rail /Circle to 10mm to
both sides.

Offset the Ring Rail to inner side of 1.0 mm, Perspective View

shows the proper placement of Curves
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e Select both outside curves and use “Loft” from Surface Menu.

Loft creates Open poly surface

AR iz

Through Finger

e Create straight line from curve menu by selecting F4 key as reference.
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Thraugh Finger

o Create 6 copies of line by using “Array Polar”

Through Finger

e Rotate all six Curves to divide the bangle in equal part.
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Perspective

e Split the poly surface in 6 equal parts El::

e Declare the top center splited polysurface in Red layer.

A G Q3 S24PM

e Apply Command “CREATE UV CURVE” from Curve Menu

Module 4 Create Computer Aided Drawing of Advance Level Jewellery Page | 53



e
Start of curve | Dagres=J rots=Crod SradTangent ) |

e Trace curves on the picture by using “Interp Curve” command -;’
=

1> £i3- Ursited.2dm - -
Fle, Edt, View, Cume, Surface, Safd, Meh, Denencon. Toecfom, Toak, nsyze, Rendee, Rhincdd, How,

i S = —

JEO A —— T o s sedata s

4] + = | Command:

1
Rese:  MLUIRREUUHN

e Trim, Rebuild, Control points,to Align the curves .

e Rebuild All Curves -*@

€3 Prbuikd Cumer x
. . Fuint coun: m l'.'_i]
e Place and adjust all curves in the UV curves. = |

= [ ke e e o cume ke
Htnl 02 5 e JOON| 3 Masiru cesalion:
H ¥ JE &
Metal 04[5 U JO | o 3 Carad || Pcnion

e 21 [0
Lh iy o i
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o Aneiper. Runde, Foiecd, Help,

e Apply UV ﬁ curve from curve menu and
change the Layer color.

o
[tfcoNmigToRY ] e g e

o — ——! Seleci Zurface 1o apply the planar curves ta: - -
ANETEHASN - e -
[ N

- ! Perspective

SEA DR == e Dl
O NN OnES I8
)N ik b Dk B

[y
Usne 03 [3, [ JOON|

User 04 E!!
a7, [N
LA s |

-
User 21 o (I oW
e 22 [37 50 [ O

[

User 23 [¥

A Edq) sorem G
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e Split and remove extra surface

o Remove or save extra surface after splitting in job bag.

e Select All Red Surfaces and perform Offset Surface (press
solid) from Surface Menu.

Module 4 Create Computer Aided Drawing of Advance Level Jewellery Page | 56



o Place Gems by selecting Surface and then press F6 or select “Gems

on surface” Command

Start

Copy

Snap
Flip

Curve

Gems

Fezet
e Select the size of gems as Dia =1.2 mm and spacing of 0.3 to 0.5 mm I

between 2 gems

ANGLE

Q|w]E]
Als|D
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=) PRONG ON
B SURFACE | A

e then Apply Prongs by selecting surface and press F6 or selecting command “Prongs
on surface”

05 o

e Set the prongs height and thickness to 0.5 mm
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e Select all Stones by clicking the light blue layer and press F6 to apply command “Gem

Cutter”

@

o This will show the cutters on the top of All gems.

Module 4 Create Computer Aided Drawing of Advance Level Jewellery
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3 BOOLEAM
BUILDER

e Then go to Solid Menu and perform “Boolean Difference”
to make gem holes.
» Builder » Tools » Gems » Setting » Cutters ® Renge

0 2 2 (NS o O

Undo

/7[;//( ko=
Pk Sl EE

* |

Differenc ove one from other)

¢ Then Apply “Array polar” to get seven (7) times repition of the pattern.

e Unhide the side circular Ring rails and draw square profile placer/cross section
as shown below.
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o Apply “Sweep1”using side ring rail and square profile placer/cross section.

(226 Hye o g2 P

AT RaMRie

Replicate the outer solid polysurface by using “Mirror” command.

2K EEH RO

e The final bangle can be got by “Boolean Union” and rendering.
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PRACTICAL: DESIGN A CHANNEL SETTING BAND (ETERNITY BAND)

LUL1: Set up of Commands for Advance Jewelry Article

Builder Menu, Eternity Builder, Channel Cutter, Cutter Profile, Boolean Difference

LU2: CREATE 2D DRAWING
e Go to Builder Menu

e Click Eternity Ring Builder

e Click Ring Rail and type your finger size. mm D:_17 mm —)

o Click Add Gems by Selecting calibrated and symmetrical round gems of size

34 mm

.y ETERNITY
Al BUILDER

ofila

Triangle

RING WIDTH EET +

SNAPS
|INFO & SETTINGS
|LAYERS
PROJECTS

Module 4 Create Computer Aided Drawing of Advance Level Jewellery

MAIN MENU

ile Wiew Utilities Measure Customn Reset
Curve ®surface © Solid e Transformm® Targets @ &t
'Builder # Tools @G Setting ® Cutters ® Rendet

.

o g, W e — e
.\' : y & '.-h.*€ P! | ) :;.'.:

+ Ring Rail

Add Gemns
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LU3: CREATE 3D DRAWING
e Click “Start” button, this will show channel set band on the screen.
. . fe ) ik b 2k B Hi
e Adjust the following parameters. .y ETERNITY |

&4! BUILDER
2 + Ring Rail

a- Ring Width : as per your design requirement

b- Channel width : as per your design requirement A Bems

c- Channel Depth : to extreme right i.e. 6.0 mm and more (for see
through)

d- Extra Height : as per your design requirement

e- Cullet to Finger : Don’t Change

f- Gem spacing : as per your design requirement

CHANNEL
e At end, click right button of mouse to come out of command. BUILDER

¢ In order to make, channel groove inside the band walls.
o Go to Cutter Menu and Click “Channel Builder”
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e Make an edge profile cutter of shape to make accurate grooves inside the wall of ﬂ
band.

o Adjust the following parameters as per your desire.
a-width, b - height , c- offset

y BODLEAN

BUILDER

e Atthe end apply ,Boolean Difference

e In order to solder both shanks , make a support cylinder of dia = 0.8 mm near the
culet of gem and apply Array Polar with no. of copies =6 or 8 ...

Difference (Remove one from other)

e Then apply Boolean Union to solder both wall of band.

e Atthe end show all gems
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PRACTICAL: DESIGN A UNIQUE BAND WITH CLUSTER SETTING
LULl: Set up of Commands for Advance Jewelry Article
Cutter Profile, Boolean Difference

LU2: CREATE 2D DRAWING

e Draw ring rain of Dia = 17 mm

III |5idetonﬁnt{gistmce=1.5 Corner=Sharp ThroughPoint Tolerance=0.001 BothSides InCPlane=No Cap=None ): |

e Offset Ring rail to 1.5 mm

Extrusion distance <2> ( Direction BothSides=No Solid=Yes Deletelnput=No ToBoundary SplitAtTangents=No SetBasePoint ).
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e Extrude both curves in Front view to thickness of 2.0 mm

¢ Using “Move” command or Gumball displace the extruded band to 3.0 mm either on left or right side in Side View.
Point to move from ( Vertical=No ): |
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e Apply Mirror Command

e NI 2K EHEO

¢ Hide both outer bands to show duplicate rings ralils.
e Using “Loft” or “Sweep 2"Commands from surface menu draw inner polysurface.

(226 ERw g%
DR sl e TN ABJQ

¢ Apply command “Create UV “ from Curve menu to open the seam surface of round polysurface on grid plane.

Select surface to create UV curves:
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e Explode the UV curves box | | Ii q%a 2 E 2 EJB |_—},b (}

e Create a mean line of UV curves box by applying command
“Mean Curve” of Offset to half of UV curves box

‘Humber of segments <4> ( Length Split=No MarkEnds=Yes GroupOutput=No ).

D|V|de the curve in 4 omts by using command * D|V|de Curve

Y (=N (A )= (@) e

ANNO A ALEOENE T

e Draw the arc pattern by using “Interp Curve “as shown bellow
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Apply command “Array along Curve “ to repeat the patterns by giving center distance of 4.55 mm

Co>EE Y AL N0

> 4
¢
ull

. el
Pl BN B

e 4! @

End of mirror plane ( Copy=Yes ): |
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LU3:CREAT 3D DRAWING

o Hide the Centre line and apply “Sweep2” command to create 2D surface with UV curves box.

(226 Hw 2P 2

e

M Ohe RayE@E@t s

e Apply Split command to pattern curves and delete the unnecessary marginal 2D surfaces

kP 2K EH O

HSelect objects to split. Press Enter when done ( Point Isocurve ):

o Highlight the unwanted splited surfaces and delete these.
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e Select 1 side of pattern and change its Layer color.

Lights [T S|
Metal 013, [& |
Metal 02 [¥ [ E S )
SESGS > ./ W

Metal 04 ¥ /G W,

Gem 01 [¥,__[GIjiM|
Gem 02 [ [ AN
Gem 03 [ BN AN
Gem 04 [¥ B AN
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¢ Change the Layer color of 1 pattern to blue and hide the remaining in green Layer.

Lights (V& ©)| [Aide ® | [Show ©
Metal 01y [& G| User01 [, |G W
Metal 02 [y [T G| —m
Metal 03 S, G || UserO03 m

User 04 [ [II[C W
Heads [¥, [& &
Finger [¥ & |
Cutting DT o !
Creation [ SN/ BT

A

¢ Re-change the color from blue to green
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Then apply “Cage Edit “Command from transform menu to uplift one side of pattern

-ﬂ ‘¢ \QJ i1 \__2, \3 L‘ !’ <

Wi ime 2 Nk
HSéIeet:control‘objéct ( BoundingBox Line Rectangle Box Deformation=Accurate PreserveStructure=No ) B '

Coordinate system <CPlane> ( CPlane World 3Point )|

iCage points ( XPointCount=4 YPointCount=3 ZPointCount=3 XDegree=3 YDegree=2 ZDegree=2 ):

This shows the bounding box and control

Up-lift the motif to height of 0.5 mm by selecting control points in the bonding box.

Select control point and move 0.5 mm down

kP 2QKEH KO
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¢ Displace /move the horizontal control points of motif inward to 0.5 mm in Looking Down View Port.

sking Down |+
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e Give thickness of 1.0 mm to pattern by applying
command” Extrude Surface Straight”

Extrusion distance <0.8> ( Direction BothSides=No Solid=Yes Deletelnput=No ToBoundary SpitAtTangents=No SetBasePoint )

o Apply “Fillet” of 0.Radius = 0.55 to 0.6 mm command from Solid Menu to round off the edges.

OO T ] T L4}

((;‘ Ne.T || ‘ ‘\ ‘\
‘SeloclodgestoﬁlhtlﬁhonﬂadUFYas NextRadius=0.55 ChainEdges PreviousEdgeSelection ): |



e Using command “Flow along Surface” from Transform menu , transfer the pattern on the band inner 2D surface.

HTarget surface - select near matching corner ( Copy=Yes Rigid=No Plane ): |

Module 4 Create Computer Aided Drawing of Advance Level Jewellery Page | 76



e Array Polar the pattern to copies of 14.

Number of items <14>:
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— —
e Apply command “Duplicate Edge to extract outer circular curves. j rd -W P ;] J o {Q@ g

||Sohctodguhdupllwh.PmEnhtMnndmu(Mm=ﬂmmt):

¢ Make inset of duplicate border to 0.5 mm.

o Apply Sweepl to make surfaces through duplicate curves and then offset the surface to 0.3 m

26 HRe @ g B 1
EI"J' JEJ@L@.{.-\
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¢ Apply Boolean Difference to get surface in-set groove.

Keep Cutter ©
OneByOne O
Force Booleanil
DoBoolean

Unda Boolean
Reset

Difference (Remove one from other)

Module 4 Create Computer Aided Drawing of Advance Level Jewellery Page | 79



¢ Go Gem Menu and load command “Gem on Curve” by selecting ISO-Curve.

Object __§
Flip

Gem Tops
Taper Gems

Taper Spacing

Eoacing B

Styles <

| e

.- ps

START SIZE

e Adjust the following gems parameters:
e Gem Size = 1.35mm

e Staring & Ending Position = 0 ~ 100 %
e Gem Space =0.3 ~0.5mm
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e The apply Prongs through Builder/Prong Adders by selecting
all gems through Blue layer.

Gem Flow 11
Gem North

L]
Styles *
Reset

we oo b4 55 KN

b @ Lol B L

e Select and adjust two(2) Sharing Prongs parameters as follows:
e Prongs Dia=0.5~0.6 mm

e Prongs Height = 0.5 ~0.8 mm

e Surface Depth = 0.3 ~0.5 mm

e Prongs Nudge =40 %

o Fillet = 68%

e Taper=129%

||ick point ( LargeDiameter=0.6 SmallDiameter=0.58 Drop=0.1 HeightLarge=0.3 HeightSmall=0.8 Fillet=68 Nudge=40 Taper=12.9 Rotate=0 MiddleProngLayout=TwoShared EndPronglLayout=Two Styles
Reset )
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o Apply “Gem Cutter “ to all round gems

o Adjust the Cutter parameter as follows:

e Cutter Profile =Square
e Lower Depth = -500 %
¢ Note that other setting will remain the same

Module 4 Create Computer Aided Drawing of Advance Level Jewellery

Bottom Dir
Surface
Rebuild

Styles
Reset
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e Apply Boolean Difference to make the gem holes in the surface

[rRUICUID |

Keep Cutteril
One By Oneil
Force Boolear

Do Boolean
Undo Boolean
Reset

P

Difference (Remove one from other)

Auto Scale Object |@ Auto Move Object

Auto Scale Cutter [  Auto Move Cutter

o At the end Apply “Mirror” to replicate the surface with gems on other side.
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» Builder » Tools » Gems » Setting ® Cutters ® Rende

¢ Finally unite all the solid polysurfaces by applying “Boolean Union”
o Re-check the band in solid form through “Object Checker”
e Find the whole Weight of metal through “Metal Weight “

e Also find the Carat weight and quantity of gems by applying command “Gem Reporter”

- (’ﬁrﬁ(%:‘:::'o*" :
CRFAA PRED
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CONVERTING CAD FILES TO CAM FILE

Matrix software has a strong algorithm to convert CAD model into machine language to produce physical wax pattern either by CNC machining

or Rapid Prototyping.

BASIC REQUIREMENTS:

Select All Curves
. i Select Open Curves
e Obiject should be a perfect 3D solid model Select Closed Curves

Select Planar Curves
Prompt Select Curves

e Hide all Curves , 2D- surfaces , Duplicate object &

Select All Surfaces
Select Open Surfaces
Prompt Select Surfaces

Gems by using “Super Select” command.

Select All PolySurfaces
Select Open PolySuifaces
Select Closed PolySurfaces
Prompt Select PolySurfaces

STEPS:

Go to “File Menu”

Select your 3D —model (so that it becomes pink).

All Gems
Prompt Select Gems

churramn All Objects

/ Last Object
Previous Objects
By Material

Click “Export selected”

p w DD PR

Target window will be opened to save your model in required directory

And give a unique name to file.

5. Select file type “ . stl”

T

|| j Save I
| Carel |

=X I Stereolithography [~ =] LI Cancel

6. Mark tick on “save small”

7. Then click “Save”

[T Save small [T Save geometry only
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This will open a window showing E BDMezh Export Dptions <]

8. Set Tolerance to 0.01mm.

Tolerance

The masimum diztance between the onginal zurface or zolid and
the polygon mesh created far the STL file.

0.01 millimeters

k. Cancel | F"reviewl Help | Detailed Contrals. .

9. It will convert into STL Mesh format by showing window.

10. Save the file in “ Binary” file type and

Then press “OK”. STL Export Options [ x|

11. It will process your 3D Model into STL CAM file. File type Approximate Size
&% Binamy 1998Kb
i Ascii 11153kKb

[¥ Export open objects

ak. I Cancel Adiuzt Mesh
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Frequently Asked Questions
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Test Yourself (Multiple Choice Questions)
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Introduction
The learner guide for Gems and Jewellery sector in “Jewellery CAD/CAM” will provide an

insight to the development of the Gem and Jewellery industry on modern means of
technological advancements. It will provide an opportunity to the learner in better
understanding of the use of Jewellery CAD/CAM software in providing state of the art
solutions to the customers. A special care is observed in designing the learner guide to bring
an easy solution in understanding with examples and practical exercises for your first time
users and also it will bring a lot learning opportunities for the mid-career workers in the
sector. Programme is to engage young people with a programme of development that will
provide them with the knowledge, skills and understanding in working as a well
professionally groomed worker or even starting own venture as an entrepreneur. The
programme has been developed to address specific issues, such as the national, regional
and local cultures, the manpower availability within the country, and meeting and the
exceeding needs and expectations of their customers. The main elements of your Teaching

and Learning Material are:

Introduction:

This includes a brief description of your guide and guidelines for you to use it effectively.
Modules:

The modules form the sections in your Teaching and Learning Material.

Learning Units:

Learning Units are the main sections within each module

Learning outcomes:

Learning outcomes of each learning units are taken from the curriculum document

Learning Elements:

This is the main content of your Teaching and Learning Material with detail of the knowledge
and skills (practical activities, projects, assignments, practices etc.) you will require achieving
learning outcomes stated in the curriculum.

This section will include examples, photographs and illustrations relating to each learning
outcome

Summary of modules:

This contains the summary of the modules that make up your Teaching and Learning
Material

Frequently asked questions:

These have been added to provide further explanation and clarity on some of the difficult

concepts and areas. This further helps you in preparing for your assessment.

Module 5 RAPID PROTOTYPE OF JEWELLERY ARTICLE USING 3D PRINTER
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Multiple choice questions for self-test:
These are provided as an exercise at the end of your Teaching and Learning Material to help

you in preparing for your assessment.

Module 5: PRODUCE PROTOTYPE OF JEWELLERY ARTICLE USING 3D PRINTER

OBJECTIVE:

The objective undermine this module is to enable a trainee in skills and knowledge required
to identify personal hazards at work place, prepare CAM file for 3d printing (rapid

prototyping) and printing 3D jewellery model on CAM machine.
MODULE SUMMARY

This module is an essential milestone in designing and understanding of the fundamentals of
computer aided jewellery manufacturing (CAM) file for 3D printing (rapid prototyping) of the
jewellery article. It will cover the basic elements and principles of jewellery manufacturing
that how trainee will transfer ideas in to practical jewellery article on CAM software.
Furthermore it emphasizes the designing of jewellery article conceptually following
manufacturing techniques to produce jewellery article with precision and accuracy. It covers
to identify personal hazards at work place, preparing CAM file for 3D printing (Rapid
prototyping) and setting up the interface of Jewellery CAM software.

The course learning units are arranged in such a way to integrate concepts and ideas
related to each topic through tools and application-oriented projects. This makes the learning
simple and systematic and enables one to gain more insight knowledge on the various tools

covered.

Module 5 RAPID PROTOTYPE OF JEWELLERY ARTICLE USING 3D PRINTER
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INTRODUCTION TO COMPUTER AIDED MANUFACTURING (CAM)

Computer aided manufacturing is “the use of computers for managing manufacturing processes of Jewellery article developed during the
Computer Aided Designing (CAD).”

CAM system takes a CAD design made in a 3D environment. CAD design is then manipulated according to defined parameters and resulting
information is fed to CAM Machine. CAM Machine then starts working on stack. These machines are controlled by computer with minimal

operator’s interaction to enhance and facilitate greater control over quality. It also allows machine to monitor the maintenance of its parts
TYPES OF CAM MACHINES

There are mainly two (2) types of CAM machines.
1- CNC Machine (Computer Numerically Controlled)
2- RP Machine (Rapid Prototype)

LEARNING UNIT 1: IDENTIFY PERSONAL HAZARDS AT WORK PLACE

OBJECTIVE:

The trainee must be aware of risk s and hazards and implement the protective measures by adopting risk control measures at work place. He
must segregate hazardous or non-hazardous wastes as per approved procedure.

LEARNING OUTCOMES
You will be able to:
» Identify hazards and risks at work place
* Identify risk control measures.
» Segregate hazardous or non-hazardous wastes as per approved procedure.

» Use personal protective equipment according to risk at workplace.
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MATERIALS REQUIRED

Personal protective equipment

SETTING UP A WORK PLACE FOR RAPID PROTOTYPING

The following instruments are used for 3D printing of Jewelry Article
Instruments and safety Material

e Personal protective equipment

e 3D Printer (Jewellery Specific) with accessories
e Ultrasonic Cleaner

e UV-Curing Unit

e Weighing Scale Machine (0-50 gm)

e Air Blower ( with regulator and nozzle)
e Nose Plier and Tweezers

e Operating system (MS Windows )

¢ Digital Vernier Calipers

e Steel Rule

e Goggles

e Fine Grit Sandpaper

e Personal protective equipment
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I

Gloves Air Blower

Weighing Machine

INTERNAL
METRIC/INCH LOCKING
s IRNS —  BUTTON W
e f LCDDISPLAY _— SCALE
Ja
ittt e s,\mmD:' S
/
O / N‘C\m\
POWER ™ ZERO DEPTH MEASURING —
. ON/OFF  SETTING BLADE
v
\/
Il
EXTERNAL
JAWS
Vernier Caliper Loupe Magnifying Glass Surgical Blade
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SAFETY & PRECAUTIONS

e Wear Face Mask when rinsing & cleaning the Prototype platform by Isopropyl Alcohol after 3D Printing.

e Exhaust Fan must be installed in the Room.

e Proper Lighting used in the Room

o Make sure Resin Container and Isopropyl Alcohol Container lid must be closed properly. Due to Alcoholic Fumes developed in the
room which may cause Irritation suffocation for eyes and mouth

e After print make sure resin must be transferred to the resin bottle from the Printer Vat (Base Plate)

e Be careful to cut supports with surgical blade.

¢ Do not make eyes contact directly to Ultra Violet Curing Unit.

o Electrical supplies must be properly installed and insulated.

Practical: Identify the safety sighs

NO ENTRY

No smoking Area Electrical Supply Authorized Personal only Fire safety
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LEARNING UNIT 2: PREPARE CAM FILE FOR 3D PRINTING (RAPID PROTOTYPING)

LEARNING OUTCOMES
You will be able to:

e Import CAD file into printable format in CAM software
e Fix surface errors of CAD file using commands & tools of CAM software.
e Perform support generation of 3D Jewellery model

e Determine estimated Production Time, Weight & Shrinkage of 3D jewellery model in CAM material.

MATERIALS REQUIRED

e 3D Printer (Jewellery Specific) with accessories

e Ultrasonic Cleaner

e UV-Curing Unit

e Weighing Scale Machine (0-50 gm)

e Air Blower ( with regulator and nozzle

e Operating system

¢ Digital Vernier Calliper

CAM AND SUPPORT GENERATIONS SOFTWARE(S) FOR JOB PREPARATION
1. Magics
2. Mesh Lab/ mesh mixer

3. Slicer Etc.

CAM FILE FORMATS
Following are the formats for CAM file. STL. OBJ. PLY .3DS etc.
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STEREO LITHOGRAPHY .STL

The most common and universal file formats for 3D printing is STL. STL stands for “Stereo Lithography” it is a 3D rendering that contains only

a single color.

DIFFERENT VIEWS OF THE SOFTWARE
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IMPORT OF *.STL FILE INTO MAGICS IMPORT *.STL FILE FROM BROWSER
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Go to Tools menu and translate the part for proper placement on platform
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Click Setup Fix Wizard Icon and analyze the errors in 3D models

m]|

Untitled - Magics 13.02 — *
File Edit View Tools Platforms Modules EOQSRP-Tools Options  Help
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WG5S a  ®ER @ W3 P G ,
SRS PSR & View Pages Cit

.

4 - . -
View
Visualization

+ Fix Wizard (Part: Earing) » Diagnostics — *
P Diagnostics M
(5] Combined Fix Advice .
Check the items you want to analyse and press the -~
'Update' button. Unchecked items will nat be
@ Mormals considered during the fixing operations. . [
[ stitching - 7 -
@Noise Shells I; Go to Advised Step I M
G Holes Diagnostics lmm)
@ Triangles |:| Full Analysis
% Overlaps = inverted normals detected ::‘gcf =
ﬁ Shells ] = bad edges detected
- biad contours detected Flatform | | Export Platform
El Profiles = near bad edges detected |I-ide | |Auto Color
= planar holes detected
[~ shellz detected q -
. possible noise shells detected
a - overlapping triangles detected
[ » intersecting triangles detected |Z|

Follow mentioned steps According to the 3D model

Module 5 RAPID PROTOTYPE OF JEWELLERY ARTICLE USING 3D PRINTER Page | 12



Unify the 3D model into One (1) Shell.
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Place supports from the bottom view

Go to Support Generation Module Menu
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Options of Support Generation Module For Manual Support
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Mark the lower Surface where supports

to be place by using Marking Module. Create New Surface from Marked Triangles
Untitled - Magics 13.02 — b
File Edit View Tools Platforms Modules EO5RP-Tools  Options  Help
0282 % 2 =
A !f”k%M XTI Y. TS
& View Pages o= x
‘L View
Visualization
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f. 5. I.. M. Copyof
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Setup and select parameter of Supports According to the Model structure

Type |Common | Point

Type 20 Plan

() Mone

(®) Point

(_Jweb
() Contour
) Gusset

Zoom Unzoom Flip View

2D Edit Regenerate 3D Regenerate 2D & 3D

Remove the center support in Edit menu Box
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Regenerate 2D & 3D support parameter.

Type | Commeon = Point

Sunken Ribs
Teeth

Teeth EQSTYLE
Reinforced
Mumber of Ribs

2D Edit

Contact Length
Minimum Rib Length | 0.3000 mm

Maxirmumn Contact 0.2500 mm
Length
Minimal Contact 0.0000 mm~2
Surface

(®) Angle

-]

() vertical Distance | 0,0000 | mm

Regenerate 3D Regenerate 2D & 3D

Support Edit Menu

Skp Empty Supparts

Support Parameters Pages. a-x
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e
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Save & Export File in .Stl Format
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LEARNING UNIT 3: PRINT 3D JEWELLERY MODEL ON CAM MACHINE

LEARNING OUTCOMES
You will be able to:

e Set parameters of CAM machine

e Load printable liquid (Resin) considering minimum & maximum level.

e Align and arrangement of multiple 3D jewellery models on machine platform
e Build the job on CAM machine.

MATERIALS REQUIRED

e 3D Printer (Jewellery Specific) with accessories
e Ultrasonic Cleaner

e UV-Curing Unit

¢ Weighing Scale Machine (0-50 gm)

e Air Blower

o Digital Vernier Callipers
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Import 3D model and setup a job for 3D print using command Menu (Rotate,move,scale,transform copy / duplicate)
link is also available https://www.youtube.com/watch?v=tLOpofT1gH8

@) File Edit Fiter View Tools Window ?

3J53% B M e R B N R

@l File Edit Filter View Tools Window 7 -8 x
E\g Z:"P.‘a“mm S:ZZ “ SR LLe L B : I Coliision avoidance
HEE: > @y -t Freehand Transformations
J Et:t w, Translate l Rotate I Scale
Close Ctrlew & inch / mm
$ Estimation of volume, building time. L —_
@ Build with automatic placement ) F%hg ‘mf'g
s cuts - i finehE}
s % inch ->mm mm ->inch

CtrleP

g ol

~ x:61.12mm

CtrisE

@ ¥ Current Renderer: [Triangles (smosthed) v Use asstandard

Open an existent document. S RAM
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https://www.youtube.com/watch?v=tLOpofT1gH8

Complete the Placement of 3D models in the Machine Platform Printer Calibration Method
The Assign file (s) is sent to 3d Printer via USB LAN OR WIFI connectivity. (Depends on the Printer used in Assign Work place)

Maintain the level of Resin
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LIST OF PRINTER CONSUMABLES ARE AS UNDER
¢ UV Resin.

* VAT (Base Plate)or Resin Container
* UV Lamp, LED, or LCD (Depends which Light source used in the 3D printer)

CASTING RESIN

. { @' | Dental denture

UV Resin Resin container Light source (DLP, LED, LCD)

Completion of print job Prepare washing Kit with Iso-propyl Alcohol
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Pt &

el

Removal of 3D model from build Plate Rinsing and cleaning for 3d Printed parts in Isopropyl Alcohol

Removal of Supports Ultra violet post Curing
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Ready 3D printed Parts
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CAD/CAM WORKFLOW

Designing in Matrix software Supports generation in Intermediate software

R L — o T Mt R, Wt o Y YT

o, W, e, O, Tt
g3 e———————————— TR IRE G e 4O 8 D O ie—————
- - - | - o ’ )
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RP Models produced Produiction in RP Machine Placement in Perfactory software
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Frequently Asked Questions
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Test Yourself (Multiple Choice Questions)
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